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1 Safety

1.1 Designated use

ControlCare is a field-based control system comprising hardware and software modules. It can be 

used to visualize, monitor and control production processes. The approved usage of the individual 

units used in the system can be taken from the corresponding parts of the operating instructions.

The software described in this particular manual allows Modbus devices (master or slave) connected 

to a SFC162 FOUNDATION Fieldbus or SFC173 PROFIBUS Field Controller to be engineered, 

configured and commissioned. In addition, appropriate control strategies can be built using the 

function blocks contained in the controller and connected devices.

1.2 Installation, commissioning and operation 

ControlCare Field Controller modules have been designed to operate safely in accordance with 

current technical safety and EU directives. Essential to their use is the ControlCare Application 

Designer software, which allows control strategies to be created for both FOUNDATION Fieldbus 

and PROFIBUS applications. Field devices, links, junction boxes, cables and other hardware 

comprising the Fieldbus sytem must also be designed to operate safely in accordance with current 

technical safety and EU directives. 

If devices are installed incorrectly or used for applications for which they are not intended, or if the 

controller is not configured correctly, it is possible that dangers may arise. For this reason, the system 

must be installed, connected, configured, operated and maintained according to the instructions in 

this and the associated manuals: personnel must be authorised and suitably qualified.

1.3 Operational safety

Location Field Controllers must be mounted in a permanent and weather-protected location in a safe area. 

The environment shall be a metal cabinet or an installation frame with a well grounded mounting 

plane. The environment shall be protected. 

Hazardous areas The controller must be connected to networks operating in explosion hazardous areas via barriers 

or other safety components. When installing components in explosion hazardous areas:

•  Ensure that all installion and maintenance personnel are suitably qualified

•  Check that all equipment has the appropriate safety certificates

•  Observe the specifications in the device certificates as well as national and local regulations.

This topic is discussed in BA013S (FOUNDATION Fieldbus Guidelines) and BA034S (PROFIBUS 

Guidelines).

EMC All modules are suitable for industrial use and conform with the following standard, see Appendix:

•  EN 61326: 1997/A1: 1998

Interference emmision: Class A apparatus

Interference immunity: as per Annex A, industrial environment

Depending upon the environment in which the bus is operating, particular attention should be paid 

to the grounding of the bus cables. This topic is discussed in BA013S (FOUNDATION Fieldbus 

Guidelines) and BA034S (PROFIBUS Guidelines).
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IP Address Field Controller is normally configured from a workstation connected into the control system 

backbone. You will require a unique IP address to set it up.

Warning

The use of IP addresses is strictly controlled. Usually your system administrator will be authorised 

to allocate unique addresses. Assigning an unauthorised address to a Field Controller may result in 

conflicts within your system and the failure of the associated devices!

Since the system can be accessed and manipulated through the various Field Contoller tools, it is 

advisable to control access both to the workstation and the folders in which the configuration is 

stored. Always make a back-up of the project.

Technical improvement Endress+Hauser reserves the right to make technical improvements to its software and equipment 

at any time and without prior notification. Where such improvements have no effect on the 

operation of the equipment, they are not documentated. If the improvements effect operation, a 

new version of the operating instructions is normally issued. 

1.4 Conventions and icons

In order to highlight safety relevant or alternative operating procedures in the manual, the following 

conventions have been used, each indicated by a corresponding icon in the margin. 

Safety conventions Icon Meaning

A note highlights actions or procedures which, if not performed correctly, may indirectly affect operation 

or may lead to an instrument response which is not planned

Caution!

Caution highlights actions or procedures which, if not performed correctly, may lead to personal injury or 

incorrect functioning of the instrument

Warning!

A warning highlights actions or procedures which, if not performed correctly, will lead to personal injury, 

a safety hazard or destruction of the instrument
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1.5 ControlCare documents

Table 1.1 indicates the documents, planned and realized, containing safety relevant information, 

installation, commissioning and operating instructions for the equipment and software associated 

with Field Controller.

All documentation available at the time of release is included on the ControlCare CD-ROM and is 

installed in Start=>Programs=>Endress+Hauser=ControlCare=Manuals during set-up.

Tab. 1-1:  ControlCare Documentation

Component Description Document type Designation Order No.

System ControlCare System Overview Operating manual BA016S/04/en 56004883

ControlCare System Design Operating manual BA039S/04/en Planned

ControlCare System Specifications Operating manual BA040S/04/en 56004888

Software Application Designer Overview Operating manual BA017S/04/en 70104301

Application Designer Drawing Tool Operating manual BA032S/04/en Planned

Application Designer: FF Tutorial Operating manual BA019S/04/en 70101151

Application Designer: PROFIBUS Tutorial Operating manual BA036S/04/en 70101152

Application Designer: MODBUS Tutorial Operating manual BA037S/04/en 70101153

Application Designer: IEC 61131-3 

Ladder Logic Tutorial

Operating manual BA038S/04/en 70101386

Application Designer: IEC 61131-3

Structured Text Tutorial

Operating manual BA056S/04/en 71060063

Field Control (OPC) Servers Operating manual BA018S/04/en 71031428

Field Controller Hardware Installation Guide Operating manual BA021S/04/en 56004885

Commissioning and Configuration Operating manual BA035S/04/en 56004887

Function Blocks Function Block Manual Operating manual BA022S/04/en 56004886

Set-Up Getting Started Operating manual BA020S/04/en 56004884

General FOUNDATION Fieldbus Guidelines Operating manual BA013S/04/en 70100707

PROFIBUS Guidelines Operating manual BA034S/04/en 56004242
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2 Modbus

This tutorial describes all steps necessary for integrating Modbus values into a SFC162 or SFC173 

Field Controller. It does not aim to give an exhaustive account of the associated Application 

Designer functions, but rather shows you one of a number of methods to reach your goal. It is 

assumed that the user is familiar with the programming of Modbus masters and slaves.

The tags and names used in the tutorial are imaginary and will be different in a proper application. 

A full description of Application Designer functions is to be found in Application Designer Overview 

BA017S/04/en. Function block descriptions are to be found in BA022S/04/en, Function Block 

manual.

2.1 Description

MODBUS is a quasi-industrial standard developed some years ago by Gould-Modicon and provides 

a messaging service that may run on a variety of physical layers. For the SFC162 and SFC173 Field 

Controllers, there are two possibilities for integrating Modbus:

•  MODBUS RTU can be connected point-to-point to the RS-232C input on the front panel. If 

appropriate a RS-232C/RS-485 (or RS-232C/RS-422) interface is required for connection to 

the device. 

•  MODBUS TCP (also known as MODBUS TCP/IP) can be connected to the Ethernet connector 

on the front panel. This allows the exchange of data between the Field Controller and a PLC, 

Remote I/O and/or operator panel. 

The MODBUS protocol exchanges data in a master-slave relationship. Each slave has a unique 

address, and the data are identified by their location in the slave address register. Certain 

characteristics of the MODBUS protocol are fixed, such as the frame format, frame sequences, 

handling of communications errors, exception conditions and the functions performed. Other 

characteristics are user selectable; these include transmission medium, baudrate, character parity, 

number of stop bits, and transmission modes. The contents of the data carried by the protocol are 

also freely selectable, i.e. nothing is said about strings, integers, floating-point numbers etc.

The MODBUS protocol controls the query and response cycle between master and slave devices. 

Only the master can initiate a transaction. A query and response may involve only a single slave, or 

it may be in the form of a broadcast, in which case the slaves do not answer. The query is contained 

in a frame that includes the address of the intended receiver, what this slave is to do, data needed 

to perform the action, and a means of checking for errors. The slave checks if errors have occurred 

and performs the desired action. After the action is performed the slave builds the response and 

returns it to the master. The master can send another message to any slave as soon as it receives a 

valid response or after a user-selected time interval. This "time-out" period has to be selected on the 

master device and depends on the slave response time.

The data can be exchanged in two transmission modes: ASCII (American Standard Code for 

Information Interchange) and RTU (Remote Terminal Unit). The major differences between them 

are the type of error check performed on the message and the number of characters used. MODBUS 

offers several read, write and test functions, each identified by a code number. They are designed 

as control commands for sensors and actuators, e.g. coils, inputs, input registers, holding or output 

registers, diagnosis and test reports, programs, polling control and reset. For MODBUS TCP the 

serial frame is simply inserted into the Ethernet data frame. In addition, not all codes are 

implemented.
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2.2 Using Modbus with ControlCare

When connected to a Modbus device, the ControlCare Field Controller SFC162 or SFC173 can be 

used as a master or slave, see Section 2.2.1 and 2.2.2. Application Designer has five function blocks 

that are used to configure the system, whereby up to 16 Master/Slave configuration blocks can be 

assigned to a Field Controller:

•  MBCF (Modbus Configuration Block)

configures the Field Controller for Modbus operation

•  MBSS (Modbus Supervision Slave)

allows the Field Controller to be used as a Modbus supervision slave, e.g. to a SCADA host

•  MBSM (Modbus Supervision Master)

allows the Field Controller to operate as a Modbus supervision master, e.g. to a SCADA host

•  MBCS (Modbus Control Slave) 

allows the Field Controller to be operated as slave, allowing a Modbus controller, e.g. a PLC, 

access to the PROFIBUS or FOUNDATION Fieldbus, depending on controller type

•  MBCM (Modbus Control Master)

allows the Field Controller to operate as a master and access Modbus slave data, e.g. from 

controller or device registers

This tutorial describes the use of a Field Controller as a Modbus Control Master or Slave. A 

description of the Modbus Supervisory Master and Modbus Supervisory Slave blocks is to be found 

in the Function Block Manual BA022S/047en.

2.2.1 Use as Modbus master

When used in master master mode, the Field Controller can read data from and write data to the 

Modbus slaves. If Modbus TCP is in use, the numer of slaves is limited to six. Fig 2-1 shows the 

possible network topology.

Fig. 2-1  Use of the Field Controller to access parameters on a Modbus line

The Field Controller uses the standard Modbus commands for read and write, making the slave data 

available for use in the control strategy or for display and trending in the operator workstation. The 

operator may also actuate Modbus slave devices and perform other supervisory functions. This type 

of application is described in Chapter 3.

High Speed Ethernet
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converter

Modbus slaves
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2.2.2 Use as a Modbus slave

Most legacy systems such as DCS or PLC have serial interface modules that support Modbus. This 

may be used to supervise Fieldbus instruments through a Modbus slave Field Controller acting as a 

gateway as shown in Fig. 2-2 and 2-3. This allows the existing system to access some of the 

capabilities provided by Fieldbus devices. 

Data in the Field Controller can be read or written by a Modbus master when the Field Controller 

operates in a Modbus slave mode. The data can be accessed in a binary format (Functions 1, 2, 5 

and 15) or through registers (Functions 3, 4, 6 and 16). This application is described in Chapter 4.

Fig. 2-2  Use of the SFC162 Field Controller to allow legacy systems access to selected FF parameters

Fig. 2-3  Use of the SFC173 Field Controller to allow legacy systems access to selected PROFIBUS parameters
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3 Field Controller as Modbus Master

3.1 Task Description

This part of the tutorial describes all steps necessary for setting up the Field Controller as a Modbus 

Control Master. It does not aim to give an exhaustive account of Application Designer functions, 

but rather shows you one of a number of methods to reach your goal. The tags and names used in 

the tutorial are imaginary and will be different in a proper application. A full description of 

Application Designer functions is to be found in Application Designer Overview BA017S/04/en. 

Function block descriptions are to be found in BA022/04/en, Function Block manual.

3.1.1 Application

For this tutorial, the case of cascade control for a heat exchanger will be used, see Fig. 3-1. 

Fig. 3-1:  Schematic diagram of heat exchanger application

A liquid flows through the heat exchanger and is heated by condensing steam. The controlled 

variable is the exit temperature of the liquid flowing through the exchanger. The manipulated 

variable is the steam flow to the exchanger. The temperature of the product defines the set point of 

the steam flow, which is controlled by a valve in order to avoid excessive waste of energy (=steam). 

The flow values are delivered by a Modbus slave (e.g. flowmeter) via the MBCM block in the Field 

Controller, which acts as Modbus master. The corresponding control strategy is shown in Fig. 3-2.

Fig. 3-2  Cascade control strategy for heat exchanger application
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3.1.2 Network

The network is assumed to be constructed as shown in Fig. 3-3. 

•  The flowmeter is a Promass 83F with Modbus RS-485 interface, acting as Modbus slave, 

suitable for steam measurement

•  The valve positioner is a Metso ND9103FN (FOUNDATION fieldbus)

•  The temperature transmitter TMT162 (FOUNDATION fieldbus)

Fig. 3-3  Network for application example

As shown in Figure 3-2, the control will be done in the TMT162 temperature transmitter and the 

ND99103FN valve positioner. As far as traffic on the bus is concerned, this is the most efficient 

method. The user has, however, the alternative of performing all control in the controller, should 

this be preferred. 

The Promass 83 delivers the flow measurement for the cascade control. To do this it must be 

connected to the RS-232 port of controller via a RS-232/RS-485 interface. The both the Field 

Controller and the flowmeter can be configured as master or slave. In this example, the Field 

Controller is used as master. 

3.1.3 Installation and commissioning

Before you can start this part of the Modbus tutorial, Application Designer must be installed on your 

computer, the SFC162 FOUNDATION Fieldbus Controller installed and commissioned and a 

connection made to your computer. Instructions on how to do this are to be found in:

•  Operating Instructions BA020S/04/en, Getting Started

•  Operating Instructions BA021S/04/en, Field Controller: Hardware Installion

•  Operating Instructions BA035S/04/en, Field Controller: Commissioning and Configuration
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3.1.4 Device ID and tag

For a FOUNDATION Fieldbus system, each device that communicates has a unique bus address and 

tag. Addresses are assigned automatically during the start-up of the system on the basis of the device 

ID. The device ID is a unique identifier that is based on a Manufacturer ID and the serial number 

of the device. When the project goes online, the actual device IDs must be assigned to virtual 

devices that have been planned in Application Designer by using the Assign Tags procedure. 

To aid the offline engineering of the network, it is necessary to keep a record of the measuring point 

tags (device tags), often as an Excel sheet. Measuring point tags are used in P&I diagrams to indicate 

the type of measurement or action performed at a particular location in a process. Table 3-1 below 

provides an example of how this might look for the application at hand. 

Tab. 3-1:  : Measuring point tag list for tutorial application

Area Process Cell Device Vendor Tag Unit Task

Pasteurization Heat Exchanger TMT162 E+H TT100

TIC100

°C Product temperature

Temperature PID

Pasteurization Heat Exchanger Promass 83F E+H FT101 kg/h Steam flow

Pasteurization Heat Exchanger ND9103FN Metso FCV102

FIC101

% Steam valve positioner

Flow PID

Pasteurization Heat Exchanger SFC162 E+H CO104 Field Controller acquiring and 

passing on flow measurement 
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3.2 Create a project

1 Start ControlCare Application Designer by clicking on the icon on your destop or via Start => 

Programs => Endress+Hauser => ControlCare => ControlCare Application Designer

2 The project starts from a blank application screen

– With the right mouse key select Project File=>New

1 The Document Type box appears: Click the option Project

2 The New Project dialog box opens:

1. Choose the folder where the project will be saved.

2. Type the name of the project in the File Name box, e.g. My Modbus project.

3. Click Save. 

If the new project is not to be created, click Cancel.

3 ControlCare Application Designer automatically creates a folder with the entered file name 

within the selected folder. 

4 The project opens with the first branches of the plant and network view already created:
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3.3 Determine the naming preferences

Before you start, you can set preferences for the way your project is created. Of particular interest 

at this stage is the labelling of the function blocks.

1 Press Project File => Preferences

– The Preferences Dialog appears

Tag Policy Tag Policy determines how the blocks are labelled by default if no tag names are entered

1 Select the folder Block and the subfolder Tag Policy, then activate the following (check box)

– Device

– Update Block Tag

2 Press OK to confirm your selection

– Application Designer will now automatically rename any blocks created in the control

strategy window as they are assigned to the devices by adding the device tag as prefix.

Tag Composition Tag Composition determines how the block identifiers are added to the block tag if no block name 

is entered.

1 Select the subfolder Tag Composition:

– Enter a mnemonic separator: for this manual the setting was "-"

Default setting is "_" and mandatory for if flexible function blocks are to be used

– Check Prefix

2 Press OK to confirm your selection

– Application Designer will now automatically compose the blocks according to your

selection, e.g. TagName-Block-n or TagName_Block_n.

Export Tag Export Tag causes tags to be automatically exported every time the project goes online

1 Select the subfolder Export Tag

– Check the Automatic button

2 Press OK to confirm your selection
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3.4 Create a fieldbus network

3.4.1 Add the controller

1 Expand the Fieldbus Networks branch in the project window and right-click on 

HSE Network 1

– Select New => Bridge to add the Field Controller SFC162

– If the Field Controller SFC173 was to be used, it would be added by New => Gateway

2 The New Bridge dialog opens

– Enter the Device Tag, e.g. CO104

– Press OK to create the bridge

3 The Field Controller SFC162 is added to the network
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3.4.2 Add a fieldbus segment

1 Right-click on the Field Controller (CO104)

– Select New Fieldbus

2 The New Fieldbus dialog opens

– Press OK to create the fieldbus with default settings

3 The fieldbus is created with the default name Fieldbus 1
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3.4.3 Add the Modbus function blocks

1 Right-click on the Fieldbus 1 leaf and select Expand

2 A new window opens with the name Fieldbus 1

– Expand the tree until all leaves until you see FBAP under the Field Controller

– Right-click on FBAP and select New Block

3 The New Block dialog for the SFC162 Field Controller opens

– In Block Type, select the function block Modbus Configuration 

– Press OK to create the block with default values

4 Repeat Step 2 and create a Modbus Control Master block 

– Depending on the number of inputs or outputs required, up to 16 MBCM blocks 

can be created)



ControlCare Application Designer: Modbus Tutorial 3 Field Controller as Modbus Master

Endress+Hauser 17

3.4.4 Add the FF field devices

Note!

• Only FOUNDATION Fieldbus devices are added to the Fieldbus network, Modbus devices are 

not shown in this tool

1 In the Fieldbus 1 window, right-click on the Fieldbus 1 leaf and select New => Device

2 The New Device dialog appears

– Select Manufacturer: Endress+Hauser

– Select Device Type: TMT162

– Enter Device Tag: TT100

– Press OK to create the device

3 Repeat Step 2 to create the Metso positioner

– Select Manufacturer: Metso Automation

– Select Device Type: Metso FBLK Interface

– Enter Device Tag: FCV102

– Press OK to create the device

4 Fieldbus 1 now looks like this
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3.5 Configure the devices

3.5.1 MBCF Modbus Configuration block

1 In the Fieldbus 1 window, right-click on the Field Controller function block CO104-MBCF-1 

and select Off Line Characterization

2 The Off Line Characterization dialog opens: Press All to show all parameters

3 Set the following parameters by double-clicking in the middle of the value space in the 

parameter line, entering or selecting the parameter from the drop-down menu, and clicking 

End Edit to register the change (MBCF block parameters are described in Chapter 6.1):

– MODE_BLK TARGET = Auto

– MEDIA = Serial

– MASTER_SLAVE = Master

– BAUD_RATE =38400 (default value in Promass 83)

– STOP_BITS = 1 (RTU, supported by Promass 83)

– PARITY = Even (RTU, supported by Promass 83)

4 Click Close to close the dialog: the parameters are added to the MBCF function block
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3.5.2 MBCM Modbus Control Master block

The MBCM function block allows 16 Modbus registers to be mapped. Each MBCM block offers:

•  Four OUT channels for reading analog values from Modbus device registers

•  Four OUT_D channels for reading discrete values from Modbus device registers

•  Four IN channels for writing analog values to Modbus device registers

•  Four IN_D channels for writing discrete values to Modbus device registers

The SCALE_LOC_XXX parameter allows each channel to be individually configured for scaling, 

slave address, register and data type. The registers are listed in the operating instructions of the 

Modbus device. Field Controller uses 5 digit register addresses, so should the slave device 

instructions show only four digits, a "3" must be prefixed for OUT values and a "4" for IN values. If 

more than four registers of a particular type are required, up to 16 MBCM blocks can be created. 

This means that a total of 64 AIs, 64 AOs, 64 DIs and 64 DOs can be mapped from the Modbus 

network. By default the LOCAL_MOD_MAP = 0, valid range is 0 – 15. 

The Promass 83 offers several measured values which can be read from different MODBUS 

registers, see below. For our example, mass flow (2007 = 32007) will be selected. 

Tab. 3-2:  Modbus registers for Promass measured values

By default, the Promass 83 sends its float number with the bytes order 1-0-3-2 and not in the 

sequence 3-2-1-0. For the Field Controller the 1-0-3-2 sequence corresponds to the DATA_TYPE 

"float". 

The values mapped to the Field Controller or sent to a Modbus slave device register can be scaled. 

The parameters:

•  FROM_EU_0

•  FROM_EU_100

•  TO_EU_0

•  TO_EU_100

allow a conversion from one set of engineering units to a second set of engineering units, by simply 

entering the lower and upper limit values of each set. In our example, the mass flow value offered 

by the Promass 83 will be scaled from 0% to 100% by entering the lower and upper range limits of 

the transmitter in the "FROM" parameters.

Full details of how to parametrize the Promass 83 flow transmitter with Modbus slave interface are 

to be found Operating Instructions BA107D and BA108D respectively.

Measured value Register 1 Register 2 Data type Access

Mass flow 2007 247 Float Read

Volume flow 2009 253 Float Read

Corrected volume flow 2011 – Float Read

Density 2013 249 Float Read

Reference density 2015 – Float Read

Temperature 2017 251 Float Read

Totalizer 1 2610 259/261 Float Read

Totalizer 2 2810 – Float Read

Totalizer 3 3010 – Float Read
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Procedure 1 Right-click on the CO104-MBCM-1 block and open the Off Line Characterization dialog

2 Click All to reveal all parameters and enter the following parameters by double-clicking in the 

middle of the parameter line, entering or selecting the parameter from the drop-down menu, 

and clicking End Edit to register the change:

– MODE_BLK TARGET = Auto

– LOCAL_MOD_MAP = 0 (first MBCM function block)

3 Now set the following SCALE_LOC_OUT1 parameters for the Modbus read value:

– FROM_EU_0 = 0

– FROM_EU_100 = 8000 (Upper range limit for Promass)

– TO_EU_0 = 0

– TO_EU_100 = 100 (%)

– DATA_TYPE = Float

– SLAVE_ADDRESS = 10 (Default address of Promass 83)

– MODBUS_ADDRESS_OF_VALUE = 32007 (mass flow)

4 Press Close to close the Off Line Characterization dialog. You should now see the parameters 

attached to the MBCM block:

5 Open Project File, then press Save, to save the project.
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3.5.3 TMT162 transducer block

Full details of how to parametrize the TMT162 temperature transmitter are to be found Operating 

Instructions BA224REN.

Transducer Block Table 3-3 shows the parameters that must be set in the TMT162 TEMP_1 transducer block

Tab. 3-3: Basic parameters for TMT162 transducer block

Order of parameters Some block parameters have a write check based on the value of others parameters. It is therefore 

important to set the parameters in the order shown in Table 3-3 (the same order in which they are 

displayed in the Off Line Characterization dialog. After parametrization of the block, the 

parameters will appear in the FOUNDATION Fieldbus tree. If you find a parameter in the wrong 

position, it can be move by dragging and dropping to the correct one.

Parametrize 1 In the Fieldbus network workspace, expand the TT100 tree until the function blocks are visible

– Right click on the transducer function block TT100-BLK-1 and select

Off Line Characterization...

2 The Off Line Characterization dialog opens: Press All to reveal all parameters.

3 Now set the following parameters to the values in Table 3-3:

– MODE_BLK TARGET = Auto

– PRIMARY_VALUE_TYPE = PV = Sensor value 1 (SV1)

– SENSOR_TYPE = Pt 100 IEC (a=3.85 E-03)

– SENSOR_CONNECTION = 2-wire

– Double-click on the "Value space" next to the parameter

– Enter a value or select a parameter from the drop-down menu

– Press End Edit to register your change

4 Press Close to quit the Off Line Characterization dialog

Parameter Function Temperature 

TT100

MODE BLOCK/TARGET Normal operating mode of block Auto

PRIMARY_VALUE_TYPE Calculation method for primary process value

• Process temperature SV1 or SV2

• Average 0.5 (SV1 + SV2) with/without redundancay

• Differential (SV1 - SV2)

• Conditional (SV1 or SV2), (SV2 if SV1 >T)

Sensor Value 1

SENSOR_TYPE Type of sensor connected to the transmitter

• All types of standardized temperature sensors

Pt 100 IEC 751

SENSOR_CONNECTION Way in which the sensor is connected

• 4-wire (if two sensors are connected only one can be 4-wire)

• 3-wire

• 2-wire

2-wire
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3.5.4 Metso ND9103FN positioner

Full details of how to parametrize the Metso ND9103FN valve positioner are to be found in the 

ND900F User Guide which can be downloaded from www.metso.com.

Transducer Block In the tutorial, you have probably only the valve positioner, but not the valve itself. In real life, the 

positioner must be told what it is driving and certain assembly information must always be entered 

into the transducer block. Rotary valve parameters are included in Table 3-4. 

Tab. 3-4:  : Basic parameters for Promass 83F transducer block

Order of parameters Some block parameters have a write check based on the value of others parameters. It is therefore 

important to set the parameters in the order shown in Table 3-4 (the same order in which they are 

displayed in the Off Line Characterization dialog. After parametrization of the block, the 

parameters will appear in the FOUNDATION Fieldbus tree. If you find a parameter in the wrong 

position, it can be move by dragging and dropping to the correct one.

Parametrize 1 In the Fieldbus network workspace, expand the FCV102 tree to reveal the function blocks. 

– Right click on the transducer function block FCV102-BLK-2 block and select 

Off Line Characterization...

2 The Off Line Characterization dialog opens: Press All to reveal all parameters

– Expand the Mode Block parameter tree

3 Now set the parameters to the values in Table 3-4:

– Double-click on the "Value space" next to the parameter

– Enter a value or select a parameter from the drop-down menu

– Press End Edit to register your change

4 Press Close to quit the Characterization dialog

5 Open Project File, then press Save, to save the project

Parameter Function Positioner 

FCV102

MODE BLOCK/TARGET Normal operating mode of block Cas

VALVE_TYPE Type of valve the positioner is actuating

• Select from drop-down menu

Rotary

FINAL_VALUE_RATE_DN Maximum travel rate in closing direction

• 0 = parameter not in use

0

FINAL_VALUE_RATE_UP Maximum travel rate in opening direction

• 0 = parameter no in use

0

POSITIONER_FAIL_ACTION Action of position on loss of electrical power or reception of 

an output signal with a bad status

• Select from drop-down menu

Close

POS_SENSOR_ROT Relationship between valve action and position sensor 

rotation

• Select from drop-down menu

Standard: 

Clockwise to close

DEAD_ANGLE_COMP Dead angle for segment and rotary valves 0

ACT_TYPE Type of positioner action 

• Select from drop-down menu

Double-acting 

actuator

PERFORMANCE_LEVEL Target performance level of valve position control

Select from drop-down menu

Optimum

CHAR_TYPE Type of linearization

• Select from drop-down menu

No 

characterization
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3.6 Create the Control Strategy

Having created a physical view of the process, the next step is to create control strategy. This is done 

in the logical view of the plant. This represents the plant as Areas/Process Cells in accordance with 

ISA S88/IEC 61518.

3.6.1 Add a Process Cell

1 Click on the "Area 1" leaf in the project and select Attributes...

2 The Attributes dialog box appears

– Enter a name for the area, e.g. Pasteurization (see Table 3-1, Chapter 3.1)

– Click OK to store your changes

3 Click on the Area leaf again and select New Process Cell...

4 The Process Cell dialog box appears

– Enter a name for the process cell, e.g. Heat Exchanger (see Table 3-1, Chapter 3.1.4)

– Click OK to store your changes

5 Open Project File, then press Save, to save the project.
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3.6.2 Add a Control Module

1 Right-click on the Process Cell leaf you just created and select Expand

1 A new window with the name of the leaf opens

– Right-click on the top leaf and select New Control Module

2 The Control Module dialog box appears

– Enter a name for the control module, e.g. Temperature Control (see Table 3-1)

– Click OK to store your changes

3 The project now looks something like this:

4 For a real project, Step 2 and 3 would be repeated until all the required control modules for a 

particular process cell have been added.

5 Open Project File, then press Save, to save the project.
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3.6.3 Create the function blocks

1 Double-click on the control module leaf or right-click and select Expand to open the Control 

Strategy workspace - this has the same name as the leaf

2 Press the Function Block button  in the toolbar and click in the workspace

– The New Block dialog appears

– Select the Manufacturer = Endress+Hauser

– Select the Device Type = TMT162

– Select the Block Type = Analog Input

– Press OK to create the function block

3 The block now appears in the strategy window with the default name
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4 Repeat Steps 2 and 3 for the Temperature PID, Flow PID and Valve AO blocks

– Temperature PID: 

Manufacturer = Endress+Hauser

Device Type = TMT162

Block Type = PID Control

– Flow PID

Manufacturer = Metso Automation

Device Type = FBLK Interface

Block Type = PID Control

– Positioner AO

Manufacturer = Metso Automation

Device Type = FBLK Interface

Block Type = Analog Output

5 The Modbus master/slave data exchange is managed by the MBCM block which you have 

already created

– In the Fieldbus 1 window expand the CO104 leaf and click on CO104-MBCM-1

– Drag and drop the block into the control strategy window

6 The control strategy now looks like this

7 Open Project File, then press Save, to save the project

Note

• In the tutorial we created the MBCM block together with the MBCF block. Is is also possible to 

create the MBCM block in the strategy window as we have done with the PID, AI and AO blocks:

Modbus Control Master MBCM

Manufacturer = Metso Automation

Device Type = SFC162 (or SFC173 with PROFIBUS Field Controller)

Block Type = Modbus Control Master

Then drag and drop it to the Field Controller in the Fieldbus Network view, see Chapter 3.6.7.
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3.6.4 Add the Function Block Links

1 In the Control Strategy workspace position the blocks according to your strategy

– The blocks can be dragged and dropped by selecting and holding down the right mouse key

– The blocks can be aligned by selecting, then via Tools => Alignment => e.g. Middle 

followed by a click on the block to which the alignment is to be made

– The Tools menu also contains other standard drawing functions such as toolbars, standard 

shapes, line thickness, colours etc.

2 Click on Function Block Link  button in the tool bar, the cursor changes to a cross

– Select the Temperature AI block with the cross: the Output Parameter Selection

dialog appears

3 Click the box next to OUT – it changes color – then click on OK

– The Output Parameter Selection dialog closes

– The cursor is now connected to a blue dotted line

– Place the Cursor in the Controller PID Block 1 and click to make the link



3 Field Controller as Modbus Master ControlCare Application Designer: Modbus Tutorial

28 Endress+Hauser

4 When the link is made, the Input Parameter Selection dialog for the PID block appears

– Click the box next to IN – it changes color – then click on OK

5 When the Input Parameter Selection dialog changes, the link is made and appears as below:

– You may have to move the parameter legends "IN" and "OUT" by selecting and positioning 

with the left mouse key depressed

6 Repeat steps 2 to 5 and make the following links between the function blocks

– PID1 and PID2 = OUT to CAS_IN

– PID2 and PID1 = BKCAL_OUT to BKCAL_IN

– CO104-MBMC-1 to PID2 = OUT1 to IN

– PID2 to Valve AO = OUT to CAS_IN

– Valve AO to PID2 = BKCAL_OUT to BKCAL_IN

7 Your Control Strategy now looks something like this

8 Open Project File, then press Save, to save the project.
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3.7 Configure the strategy

FOUNDATION Fieldbus offers the possibility of storing complete control strategies as fully 

configured generic templates. This is especially useful when particular control strategies occur 

several times within a project. The strategies are stored independent of device assignment, which is 

performed as a separate step, see Chapter 3.8.

In this tutorial, the strategy will be configured to receive the incoming process value from the input 

block as % of full range, and to output a % value to the positioner. 

3.7.1 Analog Input parameters

The function block Temperature control- A1-1 for the TMT162 has to be configured. The basic 

parameters required are shown in Table 3-5. A full description of the parameters are to be found in 

the Operating Instructions BA224REN.

Tab. 3-5:  Basic parameters for Analog Input blocks

Order of parameters Some block parameters have a write check based on the value of others parameters. It is therefore 

important to set the parameters in the order shown in Table 3-5 (the same order in which they are 

displayed in the Off Line Characterization dialog. After parametrization of the block, the 

parameters will appear in the FOUNDATION Fieldbus tree. If you find a parameter in the wrong 

position, it can be move by dragging and dropping to the correct one. 

Note

• In the tutorial we configured the MBCM block together with the MBCF block, see Chapter 3.5.2. 

If the MBCM block had been created in the strategy window as we have done with the PID, AI 

and AO blocks, it could also be configured in the same manner has described here.

Parameter Function Temperature 

TC100

MODE BLOCK/TARGET Normal operating mode of block Auto

XD_SCALE/EU_100*

XD_SCALE/EU_0

XD_SCALE/UNITS_INDEX

Upper range value for process variable

Lower range value for process variable

Unit of process variable

150 (max.850)

–50 (min. –200)

°C

OUT_SCALE/EU_100

OUT_SCALE/EU_0

OUT_SCALE/UNITS_INDEX

Upper range limit for output variable

Lower range limit for output variable

Unit of output variable

100

0

%

CHANNEL Output channels of Transducer Block aasigned to 

Ananlog Input Block.

• Primary, RJ or Sensor vlaue 1/2 depending on 

whether one or two sensors are connected

Sensor Value 1

L_TYPE Selects the type of linearisation for the input value.

• Direct: PV value = OUT value, 

Identical XD_SCALE and OUT_SCALE

• Indirect: PV value scaled to OUT value

• Indirect Square Root: as Indirect but scaling with 

root function

Indirect

PV_FTIME Output damping constant (in seconds). 1

*The range limits for the TMT162 temperature transmitter are determined by the transducer block parameters 

SENSOR_TYPE and PRIMARY_OUTPUT_TYPE. For SENSOR_TYPE = Pt100 and PRIMARY_OUTPUT_TYPE = SV_1 

the transducer block outputs a temperature signal in the range -200°C to +850°C. The XD_SCALE and OUT_SCALE 

parameters generate the OUT value of the Anlaog Input block from any part of this range, in our case -50°C to 150°C. 
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3.7.2 Configuring the Analog Input blocks

1 In the Control strategy workspace, double-click on the Temperature control AI-1 block

– The Off Line Characterization dialog opens

– Press All to display all the parameters

2 The Mode Block Target must be set to Auto.

– Expand the Mode Block parameter tree

– Double-click on the "Value space" next to the Target parameter

– Select "Auto" from the drop-down menu

– Press End Edit to register your change

3 Repeat this procedure for the remainder of the Temperature parameters in Table 3-5

– Remember to press End Edit after every change

– When all parameters have been entered, press Close to quit the Characterization dialog

4 Open Project File, then press Save, to save the project
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3.7.3 Basic PID parameters

The controller PID blocks must now be parametrized. In practice, the values for the GAIN, RESET 

and RATE as well as the setpoint value SP for the temperature loop will be known. The other values 

determine the the way the control is handled when the block moves from auto/cas or a value 

becomes bad. See also ControlCare Function Block manual BA022S/04/en.

Tab. 3-6:  Basic parameters for temperature and flow PID blocks

Order of parameters Some block parameters have a write check based on the value of others parameters. It is therefore 

important to set the parameters in the order shown in Table 3-6 (the same order in which they are 

displayed in the Off Line Characterization dialog. 

After parametrization of the block, the parameters will appear in the FOUNDATION Fieldbus tree. 

If you find a parameter in the wrong position, it can be move by dragging and dropping to the correct 

one. 

Parameter Function Temperature 

TC100

Flow 

FC101

MODE BLOCK/TARGET Normal operating mode of block Auto CAS

SP/VALUE Setpoint for product temperature 40% –

PV_SCALE/EU_100

PV_SCALE/EU_0

PV_SCALE/UNITS_INDEX

Upper range limit for process variable

Lower range limit for process variable

Unit of process variable

100

0

%

100

0

%

OUTSCALE/EU_100

OUTSCALE/EU_0

OUTSCALE/UNITS_INDEX

Upper range limit for output variable

Lower range limit for output variable

Unit of output variable

100

0

%

15

3

psi

CONTROL_OPTS Sets control options for bad input Bypass Enable Bypass Enable

BYPASS When ON, SP value is transferred to the OUT 

without the calculation of PID terms. 

OFF OFF

SP_RATE_DN

SP_RATE_UP

Rate of change from old to new, higher SP

Rate of change from old to new, lower SP

0

0

0

0

GAIN

RESET

RATE

Tuning constants for the P, I and D terms, of 

the PID block respectively.

1.5

0.1

0.5

2

0.2

0.6

SHED_OPT Behaviour when shedding from remote mode Normal shed, 

normal return 

Normal shed, 

normal return 
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3.7.4 Configure the PID blocks

1 In the Control strategy workspace, double-click on the Temperature control PID-1 block

– The Off Line Characterization dialog opens

– Press All to display all the parameters

2 The Mode Block Target must be set to Auto.

– Expand the Mode Block parameter tree

– Double-click on the "Value space" next to the Target parameter

– Select "Auto" from the drop-down menu

– Press End Edit to register your change

3 Repeat this procedure for the remainder of the Temperature PID parameters in Table 3-6

– Remember to press End Edit after each entry

– When all parameters have been entered, press Close to quit the Characterization dialog

4 Repeat Steps 1 to 3 for the Flow PID parameters in the Temperature control-PID-2 block

– Remember to set the Block Mode Target to CAS 

5 Open Project File, then press Save, to save the project
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3.7.5 Analog Output parameters

The function block Temperature control- AO-1 for the ND9103FN now has to be configured. 

The basic parameters required are shown in Table 3-7. A full description of the parameters are to 

be found in the Operating Instructions

•  ND9000F Users Guide, downloadable from www.metso.com

Tab. 3-7:  Basic parameters for Analog Output block

3.7.6 Configuring the Analog Output block

1 In the Control strategy workspace, double-click on the Temperature control AO-1 block

– The Off Line Characterization dialog opens

– Press All to display all the parameters

2 The Mode Block Target must be set to Cas.

– Expand the Mode Block parameter tree

– Double-click on the "Value space" next to the Target parameter

– Select "CAS" from the drop-down menu

– Press End Edit to register your change

3 Repeat this procedure for the remainder of the Temperature AO parameters in Table 4-3

– Remember to press End Edit after each entry

4 Open Project File, then press Save, to save the project

Parameter Function Positioner 

FCV102

MODE BLOCK/TARGET Normal operating mode of block Cas

PV_SCALE/EU_100

PV_SCALE/EU_0

PV_SCALE/UNITS_INDEX

Upper range limit for process variable

Lower range limit for process variable

Unit of process variable

100

0

%

XD_SCALE/EU_100

XD_SCALE/EU_0

XD_SCALE/UNITS_INDEX

Upper range limit for output variable

Lower range limit for output variable

Unit of output variable

15

3

psi

CHANNEL Defines the signal configuration between the AO block and 

transducer block..

• 1 = AO, valve control

• 2 = AO, no transducer connected

1 = valve control

SHED_OPT Behaviour when shedding from remote mode Normal shed, 

normal return 
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3.7.7 Store the strategy as a template

After configuration, the strategy can be stored as a template for similar applications

1 In the Strategy workspace, drag the mouse across the complete strategy with the lefthand 

button depressed, until all function blocks are selected

2 Now press the Strategy Export button  in the toolbar

– The Save As dialog appears

– If appropriate, browse to another folder

– Enter a File Name

– Press Save Entire Configuration to save the strategy

3 The strategy can be imported again pressing the Strategy Import button  in the toolbar and 

double-clicking on the appropriate file name.
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3.8 Attach the Function Blocks to the Devices

Now attach the function blocks in the control strategy to the devices where they are to run. The 

order of assignation determines the order of executions (can be changed by drag&drop).

1 Expand the Fieldbus workspace (Fieldbus 1) and the Process Cell workspace (Heat 

exchanger) 

– Note that the Heat Exchanger tree now contains all the function blocks that you created in 

the Control Strategy workspace

2 Now drag and drop the Temperature control-AI-1 block to the greyed Function Block 

Application leaf of the TT100 tree

– When you drop the block, it is attached to tree

– Its name changes to TT100-AI-1 in both views

– The question mark disappears from the block icon in the Process Cell tree

– You have now assigned the Temperature AI block to the temperature transmitter

3 Repeat Step 2 for the other function blocks

– Temperature control-PID-1 => TT100

– Temperature control-PID-2 => FCV102

– Temperature control-AO-1 => FCV102

4 Your project now looks like this

5 Open Project File, then press Save Entire Configuration, to save the project.
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3.9 Export tags

Note! 

• You should use the Export Tags function everytime you change the configuration of the project, 

so the the OPC server information is always up-to-date.

• Application Designer will do this automatically everytime you go online, if the corresponding 

preferences are set, see Chapter 3.3.

1 Active the project view by clicking in its workspace. 

2 Right click on the project name, a context menu appears

3 Select the option Export Tags...

– The Export Tags dialog confirms the successful export

– Press OK to close the dialog

4 Open Project File, then press Save Entire Configuration, to save the project
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3.10 Connect to the Field Controller

In order to download the project, the host computer and Field Controllers must be allocated 

IP addresses in the same address range. It is possible to do this on the workbench before installation 

or after the Field Controller and other components have been physically installed in the Fieldbus 

network (subnet). 

Warning

• The use of IP addresses is strictly controlled. Usually your system administrator will be authorised 

to allocate unique addresses. Assigning an unauthorised address to a Field Controller may result 

in conflicts within your system and the failure of the associated devices!

Note!

• The tools that setup the network use Ethernet services that may be blocked by Windows Firewall. 

Normally the firewall will be unblocked for the tools during installation, but it might be necessary 

to stop the firewall should they not function properly. If you are not sure how to stop the firewall, 

consult your system administrator.

Before starting, check the following:

•  Internet Protocol TCP/IP is installed on your computer

•  You have administration rights for your computer

•  You have an set of IP addresses that have been authorized by your IT department

•  Any proxy server for your Internet Browser is disabled

The procedures described in this chapter are for Windows XP. For other Windows systems consult 

your system administrator.

Note!

• When the Field Controllers are physically connected together with the Host computer via 

Ethernet, HSE Network Setup will see the them irrespective of the IP address domain to which 

they belong

3.10.1 Set the IP address of the host computer

SFC162 Field Controllers are delivered with the default IP address:

•  192.168.164.100 

In order that the host computer can communicate with the Field Controller Web Server, it must be 

allocated an IP address in the same address domain, e.g. 192.168.164.200. If you are not sure how 

to do this, consult your network administrator. 

Procedure 1 Right-click Start =>Settings =>Control Panel =>Network Connections
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2 Right-click Local Area Connection => Properties

3 Using the left mouse button, double-click Internet Protocol (TCP/IP) or

click once, then click Properties. 

4 Note the original values of IP address and Subnet Mask of the computer to restore them if 

necessary at end of the operation. 

5 Change the IP address and the Subnet Mask of the host computer to those required by the 

application. In the example, an address in the same subnet as the Field Controller. 

– IP Address 192.168.164.XXX and network mask (Subnet Mask) 255.255.255.0.

– Do not use the address 192.168.164.100,as these are reserved as default addresses for 

Field Controller SFC162

6 Click on the OK button to complete the procedure, close the other dialogs with OK and 

Close.
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3.10.2 Set the Field Controller IP address

Note!

• It is recommended that Field Controllers of the same type are introduced one by one to the 

network.

1 Call HSE Network Setup: 

Programs =>Endress+Hauser=>ControlCare=>Tools=>HSE Network Setup

2 HSE Network Setup is launched and searches for Field Controllers in the Ethernet network.

– All Field Controllers in the network appear, irrespective of their IP domain. 

If this is not the case:

– Check that the proxy server of your Internet Browser is switched off

– Check that the windows firewall is not blocking the program (switch off)

– Check all cables and switches

– If you find two or more Field Controllers with the same IP address, disconnect all but one 

from the network

3 If your computer has more than on NIC card, select the one you want to use for 

communication with the Field Controllers by ticking "Active NIC" and Press .

4 Right-click on the Field Controller, the address of which is to be changed:

the Field Controller Web Server opens

– The Web Server will only open if the host computer and the Field Controller have 

IP addresses in the same IP domain.
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5 Expand the Setup node and click Network

– Enter User Name "pcps" and Password "pcps" to open the Network Configuration dialog

– Enter the required IP address, in our example 10.125.35.180

– Enter a netmask, normally 255.255.255.0

– If required, enter a default gateway, usually address xxx.xxx.xxx.1 in the selected domain

6 Press Update to change the IP address

– You are now asked to restart the Field Controller

– Select the Restart node

– Select "No additional options" from the drop-down menu and press Restart

– Close the Web Browser

– The Field Controller disappears from HSE Network Setup and reappears with the new 

IP address

7 Now set the address of he host computer to the same domain as the Field Controllers, see 

Chapter 6.1.1 - in our example 10.125.35.200

– Restart HSE Network Setup

– Tick the Field Controller, so that it appears in the HSE Live List associated with the 

computer’s active NIC card.

– Press  to save the configuration.

– You are now ready to download the project

Note!

• If you have more than one Field Controller on the network, Repeat Steps 4 to 6 for all other Field 

Controllers, introducing them one by one to the network.
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3.11 Go online

3.11.1 Create the HSE live list

Once the Computer and Field Controller are able to communicate with each other, the connection 

to the network can be checked by creating a live list. 

1 Press the On-Line button  in the menu toolbar

– The project goes on on-line

– Red crosses temporarily appear against the Field Controller and Fieldbus network in the 

Project workspace

2 In the Project workspace, right click on HSE Network and select Live List

– A live list is generated of the devices on the HSE network
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3.11.2 Assign the HSE Device IDs

1 In the project workspace, right click on the Field Controller (CO104) and select Attributes...

– The Attributes dialog opens

2 Open the drop-down menu of the Device ID and select the Field Controller that is associated 

with the displayed TAG (in our case CO104) - the serial number is on the front panel

– Do this even though the correct ID is already displayed - the program expects it!

– Confirm your choice with OK

3 In the HSE Live list, the Field Controller icon goes grey, then reappears with the correct tag

4 Click on the Project View workspace and Export Tags..., see Chapter 3.9

– Open Project File, then press Save Entire Configuration, to save the project
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3.11.3 Create the FOUNDATION Fieldbus live list

1 In the Fieldbus network workspace, right-click on the Field Controller (CO104) and select the 

option Live List

2 The Fieldbus live list is created

– Check that all the devices in the project appear in the live list

– If this is not the case, check connections, power etc.

3.11.4 Assign the Fieldbus Device IDs

1 In the fieldbus workspace, right click on TT100 and select Attributes...

– The Attributes dialog opens

2 Open the drop-down menu of the Device ID and select the Field Controller that is associated 

with the displayed TAG (in our case TT100) - the serial number is on the nameplatel

– Confirm your choice with OK

– After a short period of time, the red cross disappears from the device in the Fieldbus network

3 Repeat the process for the rest of the devices in the Fieldbus network (FCV102)

– After a period of time, the red cross disappears from the device in the Fieldbus network
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3.11.5 Assign All Tags

1 In the Fieldbus workspace, right-click on the Fieldbus node at the top of the tree and select 

Assign All Tags

2 The Assign All Tags dialog appears with the list of device and a progress bar

– On completion, the message "Profile reading done" stands next to the Field Controller

and "Tag has been confirmed" next to the devices

– If there are any failures in tag assignment these are logged with reasons at the bottom of the 

screen.

3 As the assignment proceeds, the Field Controller transmits the change to the device

– The device goes grey in the live list

– The Field Controller initiates a new network scan

– After about 1 - 2 minutes, the device goes black and appears with the new tag

4 At the end of the process the live list looks like this

5 The "bright" dot next to the SFC162 Field Controller indicates that it is the ACTIVE LAS 

of this segment

– Any devices configured as backup LAS have an ordinary dot next to them, 

see Chapter 3.12.2

6 Click on the Project View workspace and Export Tags..., see Chapter 3.9

– Open Project File, then press Save Entire Configuration, to save the project
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3.12 Download the project

Note! 

• The procedure below describes the initial download for the entire HSE network. 

• Partial downloads can be made later from lower leaves, when changes are confined to this level

• Incremental downloads can be made to a running project by checking the boxes Incremental 

Download and Compare Parameters: Unaffected Local I/Os will hold their last values.

3.12.1 Download

When the devices in the Fieldbus live list correspond to those configured in the project, the 

download can begin.

1 In the Project workspace right-click on HSE Network and select Download

2 The Download dialog appears

– Press Start to start the download

– A log at the bottom of the screen allows you to identify download problems

3 The download will be interrupted if the project encounters a critial problem, e.g.

– The Project tags are not up-to-date => Chapter 3.10

– The Device IDs have not been assigned correctly => Chapter 6.2.2, Chapter 6.2.4

– The Device Tags have not been assigned => Chapter 6.2.5

4 When the download is successfully completed, the dialog is closed or disappears and you are 

ready to test the control strategy
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3.12.2 Configure device class

In our project the Field Controller acts as the Link Active Scheduler by default. The FOUNDATION 

fieldbus protocol allows other devices to take over the this role should the Field Controller fail. This 

ensures that any control loop not involving function blocks in the controller will continue to 

function in this event. A device can be setup to be a backup LAS by using the Configure Device Class 

function. This function is only effective when the device is online.

Note!

• If you are offline, the process finishes at Step 2. The change is registered in the project but is not 

downloaded with it. The procedure must then be repeated with the device online, otherwise a 

mismatch when you try to download. 

Procedure 1 In the Fieldbus window, right click on the Fieldbus node to open the context menu

– Select the menu Configure Device Class

2 The Device Class dialog opens

– Select the device(s) you want as backup LAS 

(usually one with few FB links, in our case TT100)

– Press >> to transfer the device to the righthand pane

(if the device does not support LAS functionality, an error message appears)

– Press Apply to confirm the choice and close the dialog.

3 When online, the Change Device Class dialog appears and shows the download progress

4 On completion the TT100 device appears in the live list with a dot indicating backup LAS 

functionality
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3.13 Make the Modbus Connection

3.13.1 Start the Modbus

The Modbus must be started after the download (and restarted on every change in the Modbus 

configuration)

1 In the Fieldbus window, expand the Field Controller tree

– Right-click on the CO104 -MBCF-1 block and select On Line Characterization

2 In the On Line Characterization dialog

– Select All to display all parameters

– Select the parameter ON_APPLY

3 Click in the value space at the center of the line and open the drop-down menu

– Select Apply

– Click End Edit to confirm your choice

– The parameter remains for two or three seconds, then reverts to None

– The Modbus starts

– Press Close to close the dialog

Note!

• This procedure must be repeated every time the Modbus configuration is changed
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3.13.2 Check the control stategy

1 Click in the Control Strategy workspace (Temperature control) and press the button  in the 

menu toolbar – the control strategy goes "on-line"

– Values appear in green when the status is good

– Values appear in red if the status is bad - at this stage this is an indication of a Fieldbus 

configuration, a strategy configuration or a device parametrization error

2 Check that the loop is working by changing the Setpoint parameter in the temperature PID 

TT100

– Double-click on the Temperature PID block TT100-PID-1, the On-line 

Characterization dialog appears

– Press the All icon to reveal all parameters

– Open the SP leaf and double-click in the space next to Value

– Enter a new SP value – for T > SP, set SP < T or vice versa

– Click End Edit to set the parameter

– Press Close to store the value (if you are prompted - answer with Yes)

3 Now check that the control loop has responded properly
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3.14 Modify the project

3.14.1 On-line characterization

Once the project is on-line you may want to change parameters to e.g. tune the control-loop or 

eliminate configuration errors. With the exception of the SP (PID block) and Apply (MBCF block) 

parameters, the function block must be put out of service before the parameter is changed:

1 In the Control strategy workspace double-click on the function block you want to modify, or in 

the Fieldbus network or Control module workspace, right-click on the function block and 

select On-line Characterization

2 The function block On-line Characterization dialog appears:

– Press the All icon to reveal all parameters

– Open the Mode leaf and double-click in the space next to Target

– Set the Target to OOS (Out of Service)

– Click End Edit to set the parameter

3 Change the parameters you wish to modify

– If appropriate, open the parameter leaf and double-click in the space next to the parameter 

you require

– Enter the new parameter or select it from the drop-down menu

– Click End Edit to set the parameter

– Repeat the procedure for all the parameters you wish to modify

4 Put the function block back into standard operating mode

– Open the Mode leaf and double-click in the space next to Target

– Set the Target back to the original value (Auto (Automatic) or Cas (Cascade))

– Click End Edit to set the parameter

– If you have modified the Modbus configuration (MBCF or MBCM blocks), start the Modbus 

again with the ON-APPLY parameter, see Chapter 3.12.1

– Check that the Mode really changes to the Target Mode (failure to do so indicates a 

configuration error)

– Press Close to store the values (if you are prompted - answer with Yes)

5 Click on the Project View workspace and Export Tags..., see Chapter 3.9

– Open Project File, then press Save Entire Configuration, to save the project

6 Put the Control stategy back "on-line" to check the results of your modification, 

see Chapter 3.12.2.
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3.14.2 Off Line characterization

You may prefer to change parameters off-line, e.g. when modifying the control strategy or adding 

new functions to the project. 

1 If you are on-line, press the Off-line button  in the menu toolbar

alternatively, in the FOUNDATION Fieldbus network or Control module workspace, right-

click on the function block and select Off Line Characterization

– The function block Off Line Characterization dialog appears

2 Change the parameters you wish to modify

– If appropriate, open the parameter leaf and double-click in the space next to the parameter 

you require

– Enter the new parameter or select it from the drop-down menu

– Click End Edit to set the parameter

– Repeat the procedure for all the parameters you wish to modify

– Press Close to store the values

3 Click on the Project View workspace and Export Tags..., see Chapter 3.9

– Open Project File, then press Save Entire Configuration, to save the project

4 Press the On-line button  in the menu toolbar to go on-line again

5 Download the modified project

– In the Project workspace right-click on HSE Network 1 and select Download

– Follow the procedure in Chapter 3.11.6.

6 Start the Modbus with the ON_APPLY parameter, see Chapter 3.12.1

7 Put the Control stategy back "on-line" to check the results of your modification, 

see Chapter 3.12.2.

Note!

• The ON_APPLY parameter must be activated after every download because the Modbus 

parameters are overwritten during the download process. ON_APPLY confirms the changes and 

starts the execution of the blocks.
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3.15 Export the configuration

The project configuration can be exported to an existing ODBC file data source, e.g. Oracle, a 

machine database, e.g. Excel to provide a record of the current status of the project or to an XML 

sheet for viewing with a browser.

3.15.1 File data source folder

The file data source must have been created before the export.

1 In the Project window, right-click on the Project icon and select Export Configuration:

2 The Select Data Source dialog box appears

3 In the File Data Source folder, select the source that describes the driver that you wish to 

connect to. You can use any file data source that refers to an ODBC driver which is installed on 

your machine.

– Use the New... button and Look In dropdown menu to browse or 

– Click the data source icon to select the driver:

– Press OK to make the connection
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3.15.2 Machine data source folder

The Machine Data Source is specific to the machine, and cannot be shared. "User" data sources are 

specific to a user on the machine; "System" data sources can be used by all users on the machine, 

or by a system-wide service. The Machine Data Source must have been created before export.

Procedure 1 In the Project window, right-click on the Project icon and select Export Configuration:

2 The Select Data Source dialog box appears

– Click on the Machine Data Source tab to open the folder

– Double-click the data source name to select the machine, e.g. Excel:

3 The Select Workbook dialog box will appear:

– Select the folder where the data file is and double-click the workbook icon.

– Your project configuration will be exported to the workbook file.

– A message box appears on completion - press OK

4 Open the Excel file to check the result:
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3.15.3 XML file

1 Click in the Project workspace and select Project File => Export => Configuration as XML

– The Export Configuration as XML dialog appears

2 Enter a File Name and Save In location, then press Save

– The project is saved as an XML file at the selected location
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3.16 Close Application Designer

When you have completed your session, close Application Designer

1 If you are on-line, press the Off-line button  in the menu toolbar

2 If you have made any modifications while you were on line, you will be prompted to store 

them

– If appropriate answer with Yes

3 Close the project by clicking on Project File => Close

4 Exit Application Designer by clicking on Project File => Exit

5 The Field Controller continues to operate with the project configured according to the last 

download/on-line correction

– If you switch off the Field Controller, the project remains stored in its memory

(back-up switch must be set as described in BA021S/04/en, Field Controller, Hardware 

Installation)

– It is initialized and re-executed as soon as the Field Controller is switched on again

3.16.1 Reconnecting

Provided your computer is operating in the same IP address domain as the Field Controller, you can 

reconnect at any time.

1 Start up Application Designer and select the Project you require

2 Press the On-line button  in the menu toolbar

3 Expand the various workplaces as required

4 Click in the Control Strategy workspace and press the button  in the menu toolbar – the 

control strategy goes "on-line" with the last configuration that was downloaded.
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4 Field Controller as Modbus Slave

4.1 Task Description

This part of tutorial describes all steps necessary for setting up the Field Controller as a Modbus 

Control Slave. It does not aim to give an exhaustive account of Application Designer functions, but 

rather shows you one of a number of methods to reach your goal. The tags and names used in the 

tutorial are imaginary and will be different in a proper application. A full description of Application 

Designer functions is to be found in Application Designer Overview BA017S/04/en. Function 

block descriptions are to be found in BA022/04/en, Function Block manual.

4.1.1 Application

For this part of the tutorial it is assumed that a controller, e.g. PLC, acting as a Modbus master 

acquires a temperature value from a FOUNDATION Fieldbus device through the Field Controller, 

which acts as a Modbus slave. The Modbus master returns a control signal to a FOUNDATION 

Fieldbus positioner, which in turn reports its new position to the Modbus controller. It is assumed 

that all control is done in the Modbus master, so the FOUNDATION Fieldbus network supplies and 

receives values only. The corresponding control strategy is shown in Fig. 4-1.

Fig. 4-1  Cascade control strategy for heat exchanger application

Since it is not the object of this tutorial to describe the programming of a Modbus controller, the 

control function has been simulated by the ModSim32 software. This provides a simple means of 

testing the application and checking what is being transmitted across the Modbus interface. The 

simulator operates via Ethernet TCP, but other simulators are available for RS232.

Note! 

• The Modbus standard restricts the maximum slave telegram length to 253 bytes, which 

corresponds to 125 measuring points of two bytes each plus three. This corresponds to a 

maximum of three control slave blocks, LOCAL_MOD_MAP 1 -3 = address range 40000 – 

40120. If more blocks are required, the master must be programmed to send more than one read 

request per cycle. 
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4.1.2 Network

The network is assumed to be constructed as shown in Fig. 4-2. 

•  The Modbus master is simulated by the ModSim32 application

•  The valve positioner is a Metso ND9103FN

•  The temperature transmitter TMT162

In the example the SFC162 is used as Modbus Slave, but the SFC173 could also be used.

Fig. 4-2  Network for application example

4.1.3 Installation and commissioning

Before you can start this part of the Modbus tutorial, Application Designer must be installed on your 

computer, the SFC162 FOUNDATION Fieldbus Controller installed and commissioned and a 

connection made to your computer. Instructions on how to do this are to be found in:

•  Operating Instructions BA020S/04/en, Getting Started

•  Operating Instructions BA021S/04/en, Field Controller: Hardware Installion

•  Operating Instructions BA035S/04/en, Field Controller: Commissioning and Configuration

High Speed Ethernet

Modbus Slave
Field Controller
SFC162 
(or SFC173)

Modbus TCP 
connection

FOUNDATION fieldbus H1

Application 
Designer

Modbus Master
ModSim32
(or PLC)

192.168.164.102

192.168.164.100
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4.1.4 Device ID and tag

For a FOUNDATION Fieldbus system, each device that communicates has a unique bus address and 

tag. Addresses are assigned automatically during the start-up of the system on the basis of the device 

ID. The device ID is a unique identifier that is based on a Manufacturer ID and the serial number 

of the device. When the project goes online, the actual device IDs must be assigned to virtual 

devices that have been planned in Application Designer by using the Assign Tags procedure. 

To aid the offline engineering of the network, it is necessary to keep a record of the measuring point 

tags (device tags), often as an Excel sheet. Measuring point tags are used in P&I diagrams to indicate 

the type of measurement or action performed at a particular location in a process. Table 4-1 below 

provides an example of how this might look for the application at hand. 

Tab. 4-1:  Measuring point tag list for tutorial application

Area Process Cell Device Vendor Tag Unit Task

Pasteurization Heat Exchanger TMT162 E+H TT100 °C Product temperature

Pasteurization Heat Exchanger ND9103FN Metso FCV102 % Steam valve positioner

Pasteurization Heat Exchanger SFC162 E+H CO104 Field Controller acting as 

Modbus slave
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4.2 Create a project

4.2.1 Create the project and add the fieldbus

1 Following the instructions in Chapter 3.2 create a new project, e.g. My Modbus Slave Project

2 Following the instructions in Chapter 3.3, set the preferences

3 Following the instructions in Chapter 3.4, add the bridge, fieldbus and devices

– In this case, do not add the MBCF and MBCM blocks to the controller yet.

4 Your project should now look something like this:

and the fieldbus like this

4.2.2 Add the Modbus blocks

1 Expand the Field Controller (CO104) leaf on the Fieldbus tree and add the Modbus blocks 

MBCF and MBCS

– Right-click on the FBAP leaf and select New Block

– Select the Modbus Configuration block

– Repeat and select the Modbus Control Slave block

2 The Fieldbus tree now looks like this

3 Open Project File, then press Save, to save the project
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4.3 Configure the devices

4.3.1 MBCF Modbus Configuration block

1 In the Fieldbus 1 window, right-click on the Field Controller function block CO104-MBCF-1 

and select Off Line Characterization

2 The Offline Characterization dialog opens: Press All to show all parameters

3 Set the following parameters by double-clicking in the middle of the parameter line, entering or 

selecting the parameter from the drop-down menu, and clicking End Edit to register the 

change (MBCF block parameters are described in Chapter 6.1):

– MODE_BLK TARGET = Auto

– MEDIA = TCP/IP

– MASTER_SLAVE = Slave

– DEVICE_ADDRESS =1 

– TIMEOUT = e.g. 1000

The value entered must be greater than the write cycle of the Modbus master

– Click Close to close the dialog: the parameters are added to the MBCF function block



4 Field Controller as Modbus Slave ControlCare Application Designer: Modbus Tutorial

60 Endress+Hauser

4.3.2 MBCS Modbus Control Slave block

The MBCS function block allows fieldbus and Modbus data to be exchanged through 16 Modbus 

registers: if required, the register addresses in the Field Controller can be calculated from the 

LOCAL_MOD_MAP table, see Chapter 6.2. Each block offers:

•  Four OUT channels for reading analog values from the Field Controller Modbus registers

•  Four OUT_D channels for reading discrete values from the Field Controller Modbus registers

•  Four IN channels for writing analog values to the Field Controller Modbus registers

•  Four IN_D channels for writing discrete values to the Field Controller Modbus registers

The SCALE_CONV_XXX parameter allows each channel to be individually configured for scaling 

and data type. If more than four registers of a particular type are required, up to 16 MBCM blocks 

can be created: in this case the various blocks are identified by the parameter LOCAL_MOD_MAP. 

This means that a total of 64 AIs, 64 AOs, 64 DIs and 64 DOs can be mapped from the Modbus 

network. By default LOCAL_MOD_MAP = 0, valid range 0 – 15. 

For the tutorial we require the IN_1, IN_2 and OUT_1 channels. When LOCAL_MOD_MAP is set 

to zero, the data will be mapped to the registers in Table 4-2.

Tab. 4-2:  Modbus registers for exchange of data

By default, the Field Controller sends its float number with the bytes order 1-0-3-2 and not in the 

sequence 3-2-1-0. The 1-0-3-2 sequence corresponds to the DATA_TYPE "float"

The values mapped to the Field Controller or sent to a Modbus device register can be scaled. The 

parameters:

•  FROM_EU_0

•  FROM_EU_100

•  TO_EU_0

•  TO_EU_100

allow a conversion from one set of engineering units to a second set of engineering units, by simply 

entering the lower and upper limit values of each set. In our example, no scaling will be done and 

the default parameters 0 and 1 entered for both "TO" and "FROM" parameters.

The STATUS_OUT_Dx and STATUS_OUTPUT elements used in the OUT parameters define the 

following rules for OUTPUT STATUS parameters:

•  If the option "Set by master" is used, the output status will behave exactly as the Fieldbus 

protocol works, in other words, the status will reflect the value which the master is writing but 

if after TIMEOUT (defined in MBCF block) the status is not updated, this status will be forced 

to BAD COMMUNICATION. For this reason the TIMEOUT parameter in the MBCF 

block must be set to a value greater than the write cycle of the Modbus master. 

•  If the user defines this element with anything other than "Set by master", this value will be 

reflected in output status, while communication OK, otherwise the status goes to BAD 

COMMUNICATION..

Parameter Channel Register Data type Access

Temperature IN_1 40001 Float Write

Status 40017

Positioner OUT_1 40009 Float Read

Status 40021

Back calculation IN_2 40003 Float Write

Status 40018
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Procedure 1 Right-click on the CO104-MBCS-1 block and open the Off Line Characterization dialog

2 Click All to reveal all parameters and enter the following parameters by double-clicking in the 

middle of the parameter line, entering or selecting the parameter from the drop-down menu, 

and clicking End Edit to register the change:

– MODE_BLK TARGET = Auto

– LOCAL_MOD_MAP = 0

3 Now set the following SCALE_LOC_CONV1 parameters for the IN_1 and IN_2 channels:

– FROM_EU_0 = 0

– FROM_EU_100 = 1 

– TO_EU_0 = 0

– TO_EU_100 = 1

– DATA_TYPE = Float

4 Set the following SCALE_LOC_CONV1 parameters for the OUT_1 channel:

– FROM_EU_0 = 0

– FROM_EU_100 = 1 

– TO_EU_0 = 0

– TO_EU_100 = 1

– DATA_TYPE = Float

– STATUS_OUTPUT = "Good_Cascade::NonSpecific:NotLimited"

5 Press Close to close the Off Line Characterization dialog. You should now see the parameters 

attached to the MBCM block:

6 Open Project File, then press Save, to save the project.
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4.3.3 Configure the Fieldbus devices

1 Configure the devices according to Tables 4-3 and 4-4 as described in Chapter 3.5.3 and 3.5.4 

respectively.

2 Open Project File, then press Save, to save the project.

TMT162 Table 4-3 shows the parameters that must be set in the TMT162 transducer block

Tab. 4-3:  Basic parameters for TMT162 transducer block

ND9103FN Rotary valve parameters are included in Table 4-4. 

Tab. 4-4:  Basic parameters for Metso ND9103FN transducer block

Parameter Function Temperature 

TT100

MODE BLOCK/TARGET Normal operating mode of block Auto

PRIMARY_VALUE_TYPE Calculation method for primary process value

• Process temperature SV1 or SV2

• Average 0.5 (SV1 + SV2) with/without redundancay

• Differential (SV1 - SV2)

• Conditional (SV1 or SV2), (SV2 if SV1 >T)

Sensor Value 1

SENSOR_TYPE Type of sensor connected to the transmitter

• All types of standardized temperature sensors

Pt 100 IEC 751

SENSOR_CONNECTION Way in which the sensor is connected

• 4-wire (if two sensors are connected only one can be 4-wire)

• 3-wire

• 2-wire

2-wire

Parameter Function Positioner 

FCV102

MODE BLOCK/TARGET Normal operating mode of block Auto

VALVE_TYPE Type of valve the positioner is actuating

• Select from drop-down menu

Rotary

FINAL_VALUE_RATE_DN Maximum travel rate in closing direction

• 0 = parameter not in use

0

FINAL_VALUE_RATE_UP Maximum travel rate in opening direction

• 0 = parameter no in use

0

POSITIONER_FAIL_ACTION Action of position on loss of electrical power or reception of 

an output signal with a bad status

• Select from drop-down menu

Close

POS_SENSOR_ROT Relationship between valve action and position sensor 

rotation

• Select from drop-down menu

Standard: 

Clockwise to close

DEAD_ANGLE_COMP Dead angle for segment and rotary valves 0

ACT_TYPE Type of positioner action 

• Select from drop-down menu

Double-acting 

actuator

PERFORMANCE_LEVEL Target performance level of valve position control

Select from drop-down menu

Optimum

CHAR_TYPE Type of linearization

• Select from drop-down menu

No 

characterization
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4.4 Create the Control Strategy

Having created a physical view of the process, the next step is to create control strategy. This is done 

described in Section 3.6.

4.4.1 Add a Process Cell

1 Click on the "Area 1" leaf in the project and select Attributes...

– The Attributes dialog box appears

– Enter a name for the area, e.g. Pasteurization (see Table 3-1, Chapter 3.1.4)

– Click OK to store your changes

2 Click on the Area leaf again and select New Process Cell..

– The Process Cell dialog box appears

– Enter a name for the process cell, e.g. Heat Exchanger (see Table 3-1)

– Click OK to store your changes

3 Open Project File, then press Save, to save the project.

4.4.2 Add a Control Module

1 Right-click on the Process Cell leaf you just created and select Expand

– A new window with the name of the leaf opens

2 Right-click on the top leaf and select New Control Module

– The Control Module dialog box appears

– Enter a name for the control module, e.g. Temperature Control (see Table 3-1)

– Click OK to store your changes

3 The project looks something like this

4 Open Project File, then press Save, to save the project.
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4.4.3 Create the function blocks

1 Double-click on the control module leaf or right-click and select Expand to open the Control 

Strategy workspace - this has the same name as the leaf

2 Press the Function Block button  in the toolbar and click in the workspace

– The New Block dialog appears

– Select the Manufacturer = Endress+Hauser

– Select the Device Type = TMT162

– Select the Block Type = Analog Input

– Press OK to create the function block

3 The block now appears in the strategy window with the default name

4 Repeat Steps 2 and 3 for the Positioner AO block

– Positioner AO

Manufacturer = Metso Automation

Device Type = FBLK Interface

Block Type = Analog Output

5 The flow value is supplied by the MBCS block which you have already created

– In the Fieldbus 1 window expand the CO104 leaf and click on CO104-MBCS-1

– Drag and drop the block into the control strategy window

6 The control strategy now looks like this

7 Open Project File, then press Save Entire Configuration, to save the project

Note

• In the tutorial we created the MBCS block together with the MBCF block. Is is also possible to 

create the MBCS block in the strategy window as we have done with the AI and AO blocks, and 

then drag and drop it to the Fieldbus, see Chapter 3.8.
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4.4.4 Add the Function Block links

1 In the Control Strategy workspace position the blocks according to your strategy

2 Click on Function Block Link  button in the tool bar, the cursor changes to a cross

3 Select the Temperature AI block with the cross: the Output Parameter Selection

dialog appears

– Click the box next to OUT – it changes color – then click on OK

– The Output Parameter Selection dialog closes

– The cursor is now connected to a blue dotted line

– Place the Cursor in the CO104-MBCS-1 block and click to make the link

– When the link is made, the Input Parameter Selection dialog for the PID block appears

– Click the box next to IN_1 – it changes color – then click on OK

4 Repeat steps 2 to 3 and make the following links between the function blocks

– CO104-MBMS-1 to Valve AO = OUT_1 to CAS_IN

– Valve AO to CO104-MBMS-1 = BKCAL_OUT to IN_2

5 Your Control Strategy now looks something like this

6 Open Project File, then press Save Entire Configuration, to save the project.
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4.5 Configure the strategy

4.5.1 Configure the blocks

1 In the Control strategy workspace, double-click on the Temperature control AI-1 block

Set the parameters in Table 4-5 as described in Chapter 3.7.2

2 In the Control strategy workspace, double-click on the Temperature control AO-1 block

Set the parameters in Table 4-6 as described in Chapter 3.7.6

3 Open Project File, then press Save, to save the project

Analog Input parameters

Tab. 4-5:  Basic parameters for Analog Input block

Analog Output parameters

Tab. 4-6:  : Basic parameters for Analog Output block

Parameter Function Temperature 

TC100

MODE BLOCK/TARGET Normal operating mode of block Auto

XD_SCALE/EU_100*

XD_SCALE/EU_0

XD_SCALE/UNITS_INDEX

Upper range value for process variable

Lower range value for process variable

Unit of process variable

150 (max.850)

–50 (min. –200)

°C

OUT_SCALE/EU_100

OUT_SCALE/EU_0

OUT_SCALE/UNITS_INDEX

Upper range limit for output variable

Lower range limit for output variable

Unit of output variable

100

0

%

CHANNEL Output channels of Transducer Block aasigned to 

Ananlog Input Block.

• Primary, RJ or Sensor vlaue 1/2 depending on 

whether one or two sensors are connected

Sensor Value 1

L_TYPE Selects the type of linearisation for the input value.

• Direct: PV value = OUT value, 

Identical XD_SCALE and OUT_SCALE

• Indirect: PV value scaled to OUT value

• Indirect Square Root: as Indirect but scaling with 

root function

Indirect

PV_FTIME Output damping constant (in seconds). 1

Parameter Function Positioner 

FCV102

MODE BLOCK/TARGET Normal operating mode of block Cas

PV_SCALE/EU_100

PV_SCALE/EU_0

PV_SCALE/UNITS_INDEX

Upper range limit for process variable

Lower range limit for process variable

Unit of process variable

100

0

%

XD_SCALE/EU_100

XD_SCALE/EU_0

XD_SCALE/UNITS_INDEX

Upper range limit for output variable

Lower range limit for output variable

Unit of output variable

15

3

psi

CHANNEL Defines the signal configuration between the AO block and 

transducer block..

• 1 = AO, valve control

• 2 = AO, no transducer connected

1 = valve control

SHED_OPT Behaviour when shedding from remote mode Normal shed, 

normal return 
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4.5.2 Attach the Function Blocks to the Devices

Now attach the function blocks in the control strategy to the devices where they are to run. The 

order of assignation determines the order of executions (can be changed by drag&drop).

1 Expand the Fieldbus workspace (Fieldbus 1) and the Process Cell workspace (Heat 

exchanger) 

2 Now drag and drop the Temperature control-AI-1 block to the greyed Function Block 

Application leaf of the TT100 tree

– When you drop the block, it is attached to tree

– Its name changes to TT100-AI-1 in both views

– You have now assigned the Temperature AI block to the temperature transmitter

3 Repeat Step 2 for the other function block

– Temperature control-AO-1 => FCV102

4 Your project now looks like this

5 Open Project File, then press Save, to save the project.

4.5.3 Export tags

1 Active the project view by clicking in its workspace. 

2 Right click on the project name, a context menu appears

– Select the option Export Tags...

– The Export Tags dialog confirms the successful export

– Press OK to close the dialog

3 Open Project File, then press Save, to save the project
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4.6 Go Online

Now go online as described in more detail in Chapter 3.11.

4.6.1 Connect to the Field Controller

After the Field Controller and other components have been physically installed in the network, 

connection must be established as described in Chapter 3.10. 

4.6.2 Create the HSE live list

Once the Computer and Field Controller are able to communicate with each other, the connection 

to the network can be checked by creating a live list as decribed in Chapter 3.11.1

1 Press the On-Line button  in the menu toolbar

– The project goes on on-line

– Red crosses appear against the Field Controller and Fieldbus network in the 

Project workspace

2 In the Project workspace, right click on HSE Network and select Live List

– A live list is generated of the devices on the HSE network

4.6.3 Assign the HSE Device IDs

Assign the HSE Device IDs as decribed in Chapter 3.11.2

1 In the project workspace, right click on the Field Controller (CO104) and select Attributes...

– The Attributes dialog opens

2 Open the drop-down menu of the Device ID and select the Field Controller that is associated 

with the displayed TAG (in our case CO104) - the serial number is on the front panel

– Do this even though the correct ID is already displayed - the program expects it!

– Confirm your choice with OK

3 In the HSE Live list, the Controller Icon goes grey, then reappears with the correct tag

4 Click on the Project View workspace and Export Tags..., see Chapter 3.9

– Open Project File, then press Save Entire Configuration, to save the project
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4.6.4 Create the FOUNDATION Fieldbus live list

Create the Foundation Fieldbus live list as described in Chapter 3.11.3

1 In the Fieldbus network workspace, right-click on the Field Controller (CO104) and select the 

option Live List: The Fieldbus live list is created

– Check that all the devices in the project appear in the live list

– If this is not the case, check connections, power etc.

4.6.5 Assign the Fieldbus Device IDs

Assign the Fieldbus Device IDs as decribed in Chapter 3.11.4.

1 In the fieldbus workspace, right click on TT100 and select Attributes...

– The Attributes dialog opens

2 Open the drop-down menu of the Device ID and select the Field Controller that is associated 

with the displayed TAG (in our case TT100) - the serial number is on the nameplatel

– Confirm your choice with OK

– After a short period of time, the red cross disappears from the device in the 

Fieldbus network

3 Repeat the process for the rest of the devices in the Fieldbus network (FCV102)

– After a period of time, the red cross disappears from the device in the Fieldbus network

4.6.6 Assign All Tags

1 In the Fieldbus workspace, right-click on the Fieldbus node at the top of the tree and select 

Assign All Tags

2 The Assign All Tags dialog appears with the list of device and a progress bar

– On completion, the message "Profile reading done" stands next to the Field Controller

and "Tag has been confirmed" next to the devices

3 As the assignment proceeds, the Field Controller transmits the change to the device

– The device goes grey in the live list

– The Field Controller initiates a new network scan

– After about 1 - 2 minutes, the device goes black and appears with the new tag

4 At the end of the process the live list looks like this

5 The "bright" dot next to the SFC162 Field Controller indicates that it is the ACTIVE LAS 

of this segment

6 Click on the Project View workspace and Export Tags..., see Chapter 3.9

– Open Project File, then press Save Entire Configuration, to save the project
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4.7 Download the project

Note! 

• The procedure below describes the initial download for the entire HSE network. 

• Partial downloads can be made later from lower leaves, when changes are confined to this level

• Incremental downloads can be made to a running project by checking the boxes Incremental 

Download and Compare Parameters: Unaffected Local I/Os will hold their last values.

When the devices in the Fieldbus live list correspond to those configured in the project, the 

download can begin.

1 In the Project workspace right-click on HSE Network and select Download

2 The Download dialog appears

– Press Start to start the download

– A log at the bottom of the screen allows you to identify and non-critical download problems

3 The download will be interrupted if the project encounters a critial problem, e.g.

– The Project tags are not up-to-date => Chapter 3.10

– The Device IDs have not been assigned correctly => Chapter 6.2.2, Chapter 6.2.4

– The Device Tags have not been assigned => Chapter 6.2.5

4 When the download is successfully completed, the dialog is closed, and you are ready to test 

the control strategy
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4.8 Make the Modbus Connection

4.8.1 Start the Modbus

The Modbus must be started after the download (and restarted on every change in the Modbus 

configuration)

1 In the Fieldbus window, expand the Field Controller tree

– Right-click on the CO104 -MBCF-1 block and select On Line Characterization

2 In the On Line Characterization dialog

– Select All to display all parameters

– Select the parameter ON_APPLY

3 Click in the value space at the center of the line and open the drop-down menu

– Select Apply

– Click End Edit to confirm your choice

– The parameter remains for two or three seconds, then reverts to None

– The Modbus starts

– Press Close to close the dialog

Note!

• This procedure must be repeated every time the Modbus configuration is changed, including 

project download.
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4.8.2 Start the Modbus simulator

1 Start the ModSim32 or other Modbus simulator as master from the desktop or through the 

Explorer

2 Set up the communication by selecting Connections => Connect

– Set the Connect Using to Remote TCP/IP Server

– Enter the IP Address of the Field Controller (here default 192.168.164.100)

– Press OK to confirm the settings

3 Set up the data display by selection Setup => Display Options

– Select Show Data

– Select Floating Pt

4 Select the view Holding Registers from the drop-down menu in the user interface. 

– Set the Address to 0001 and Length to 50

– You should now be able to see IN_1 and IN_2 in registers 40001 and 40003

5 Double-click on register 40009 and enter a value to simulate the OUT_1 value.
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4.8.3 Check the control stategy

1 Click in the Control Strategy workspace (Temperature control) and press the button  in the 

menu toolbar – the control strategy goes "on-line"

– Values appear in green when the status is good

– Values appear in red if the status is bad - at this stage this is an indication of a Fieldbus 

configuration, a strategy configuration or a device parametrization error

4.8.4 Modify, export and close the project

See Chapters 3.13 to 3.15.
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5 Trouble-Shooting

5.1 Factory initialisation and reset

Warning!

• Do not use the pushbuttons located in the Field Controller unless you are certain that you want 

to reset the system. 

Fig. 5-1:  Front panels of SFC162 and SFC173 Field Controllers

Two pushbuttons, located in the Field Controller module allow the system to be initialised and reset. 

The function and effect of the buttons is described in the table below. 

• To "click " the pushbuttons use a pointed instrument (e.g. a ballpoint pen). 

• Once started, any mode (Factory Init or HOLD Mode) can be exited by keeping the right 

pushbutton pressed and releasing the left pushbutton.

• If you loose the count of the times that the right pushbutton was pressed, check the rate at which 

the FORCE LED is flashing. It will return to a rate of once a second after the fourth touch (the 

function is rotative).

Function Effect

Reset Click the right pushbutton (see details in Fig. 5.1) and the system will execute the RESET, 

taking some seconds for correct system initialization. In accordance with the procedure via FC 

Tools, a new IP will be attributed automatically or the last configured IP will be accepted for the 

system. Verify that the RUN and ETH LNK LEDs remain lit.

Factory Init Keep the left pushbutton pressed and then click the right pushbutton, checking that the FORCE 

LED flashes once a second. Release the left push button and the system will execute the RESET, 

deleting the previous configurations.

HOLD mode Keep the left pushbutton pressed and then double click the right pushbutton, checking that the 

assuring that FORCE LED flashes twice a second.Release the left pushbutton and the system will 

execute the RESET and then enter the HOLD mode. Verify that the HOLD and ETH LNK 

LEDs remain lit. With the Field Controller in this mode, you can use the FC Tools Wizard to 

update the firmware or change the IP address.

Use the Reset again, case you want to return to the execution mode (RUN).
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5.2 Exchanging devices

It may be that during Device ID assignment, see Chapters 6.2.2 and 6.2.4, Application Designer 

detects a revision mismatch. If this occurs, the device revision must be changed in the project and 

the project downloaded as described below. 

Note! 

• For exchange of controllers, see Chapter 7.3, Updating the Firmware, in BA035S/04/en

• The process also applies to exchange of devices of the same type but different device revision

• In the case of devices from different manufacturers, manually check the incompatibilities (press 

NO at Step 3). Additional adjustments to the strategy may also be required.

• Device revisions not supported by Application Designer can be downloaded from 

www.fieldbus.org and integrated using the Import Device Support function

Procedure 1 Open the project in Application Designer and select the device to be updated, here SFC162

– Right-click on the node and select Exchange...

2 The Exchange dialog for the device appears

– Open the Device Rev menu and select the correct revision

– Press OK to confirm the change and close the dialog.

3 The Incompatibilities dialog may now appear

– Press OK to automatically update all links

– Close the successful exchange dialog by pressing OK.

4 Export the tags, press  to go on-line and download the project as described in Chapter 3.12.
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5.3 Trouble-shooting tables

5.3.1 Field Controller 

Problem Remedy

1 HSE Network Setup/FC Tools does not find any 

Field Controller

• Disable the Windows firewall (normally a message 

appears ask whether you should unbock the program)

• Disable the proxy server for your Internet browser

• Check that you are using the correct Ethernet cables, 

see ETH LINK below

• Check that all etehrnet switches are powered up

• Check that the network adapter is on and OK: Execute a 

PING command to its own IP, via DOS PROMPT.

• Check if the Ethernet connection is OK: Execute a PING 

command to the Field Controller.

2 Field Controller appears intermittently in FC Tools Host and Field Controller are in different subnets.

• Normal behaviour, but for firmware download both host 

and Field Controller must be in the same subnet

3 HSE Network Setup/FC Tools does not show all the 

Field Controllers that are in the network

There is probably an IP address conflict in the network.

• Disconnect all the Field Controllers except one from the 

from the sub-network

• If necessary, change its IP address

• Now reconnect the other Field Controllers one after the 

other, if necessary changing their IP addresses

4 Field Controller Web Server does not open No Ethernet connection

• Disable the Windows firewall

• Disable the proxy server for your Internet browse

• Wrong subnet IP address

Host and Field Controller must be in same subnet

• Wrong subnet mask

Host and Field Controller must have same subnet mask

5 Firmware begins to execute but after a certain time it 

stops

It might be a configuration problem. 

• Use the Factory Init procedure and configure the Field 

Controller again. 

• If the problem persists, see the relevant chapter in 

Operating Instructions BA035S/04/en, Field Controller, 

Commissioning and Configuration

6 HOLD LED remains lit If the HOLD LED remains lit after the Field Controller has 

been turned on, the firmware may be invalid. 

• Update the firmware, see the relevant chapter in 

Operating Instructions BA035S/04/en, Field Controller, 

Commissioning and Configuration

7 ETH LNK LED does not light Check if the cable is connected correctly, or that the cable is 

not damaged. Check the specification of the cables:

• SFC954 - Cable Standard.  To be used in a network 

between the Field Controller and a Switch/Hub.

(preferred configuration)

• SFC955 - Crossed Cable (Cross).  To be used point to 

point between a PC and the Field Controller

(some PCs/laptops may have problems with crossed 

cable)
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5.3.2 Application Designer

Problem Remedy

1 Field Controller does not appear in HSE live list No connection to Field Controller

• See Remedies for Items 1, 2 and 4, Chapter 7.3.1

• Field Controller is on HOLD, set it to RUN mode

• IP address is not configured correctly, use PING to check

2 Field Controller appears but always stays grey in HSE 

Live List

No connection to Field Controller

• Check that host and Field Controller are in same subnet

3 Red cross appears on the Field Controller No communication with Field Controller

• No Ethernet connection with Field Controller, 

check connection, IP address etc, see above

• No Device ID set in the Field Controller (Attributes)

4 Red cross appears on Fieldbus/Profibus No communication with fieldbus/Profibus

• No communicaton with Field Controller, see above

• Fieldbus/Profibus not connected to controller

5 Red cross appears on field device No communication with fieldbus device

• No communicaton with Field Controller, see above

• No communicaton with fieldbus, see above

• No Device ID set (Attributes)

• Tag not assigned (Assign Tag)

6 A device does not appear in the live list Communication error

• The device is not powered up

• The project has been updated but no download has been 

made yet

7 Configuration will not download You have either a communication problem or the 

configuration is not complete

• Check that you are on-line - press the On-line button

• Check that your computer is in the same address subnet

• Check that you have assigned the Field Controller tag

• Check that you have exported all tags OPC server

• Check that the parameters are in the recommended order

• Check that the OPC server is running (look for icon in 

bottom line)

• Try "Update" from the Field Controller node and 

download again

9 Parameter appears red in the on-line control strategy The parameter has a bad status

• Check that the Block Mode is Auto (or Cas)

• Check that the block has been correctly configured

• Check that the device is still live (live list)

• Check that the device address is the same as that you 

have in your configuration (live list)

• Check that the parameter has been correctly configured

• Check that the tags were exported (Export Tags)

10 FB links do not work Project not downloaded correctly, e.g. partial download 

when bridge has HSE links

• Repeat full download from the HSE Network node
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5.3.3 Modbus

Problem Remedy

No communication via Modbus RS-232 • If you have changed the configuration of a Modbus block, 

check that you have restarted the bus by using the 

ON_APPLY parameter, Chapter 3.17

• Check that the MEDIA parameter is correct, 

TCP or serial, Chapter 3.5.1

• Check that the Field Controller and Modbus device are 

using the same communication settings: RTU/ASCII, 

Data bytes, Stop bits, Parity, Baudrate, Chapter 3.5.1

• Check that you are using the correct Modbus Block, 

Chapter 3.5.2, Chapter 4.3.2

• Check that you are using the correct Modbus addresses

• Check that the Controller connector, all cables and any 

interfaces, e.g. RS-232/RS-485 are correctly wired

No communication via Modbus TCP • Check that the IP addresses are in the same domain

• Check that any slave IP addresses have been property 

entered, Chapter 6.2

• Check that the correct cables have been used, see 

Chapter 5.2, ETH LNK LED and any switches etc. are 

powered

• If you have changed the configuration of a Modbus block, 

check that you have restarted the bus by using the 

ON_APPLY parameter, Chapter 3.17

A Modbus block does not switch to "Auto" but remains 

"OOS"

• Check the the Mode Block target is set to "Auto"

• Check that the Local Mod Map of each Modbus Block 

has a unique identifier between 0 and 15

• Check that the Modbus has been started by using the 

ON_APPLY parameter, Chapter 3.17

Local Mod Map identifier is not accepted • Check that value is between 0 and 15

• Check that no other Modbus block of the sdame time is 

using the value you entered

A static value in the Modbus Block was changed, but the 

value does not update.

• Put the block out of service (OOS) before editing the 

parameter. 

• After the edit, put the block back to "Auto" and restart the 

bus with ON_APPLY

The Modbus parameters cannot be found or displayed • Check that you are looking at the correct registers

• Check that the data format has been set correctly

Chapter 6.

Status of Modbus value alsways bad • Check TIMEOUT parameter is greater than Modbus 

master write cycle, see Chapter 4.3.1
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6 Function Block Descriptions

A more detailed description of the blocks MBSC and MBSS are to be found in the Function Block 

manual BA022S/04/en.

6.1 MBCF Modbus Configuration Block

The MBCF allows the Field Controller to be configured for Modbus TCP or RTU operation. 

•  The parameters MEDIA and MASTER_SLAVE determine the medium and mode of Modbus 

communication

•  The Modbus address of Field Controller is entered in DEVICE_ADDRESS. It is 1 by default and 

must only be entered if the Field Controller is to be a slave

•  For Modbus RTU, the communication parameters BAUD_RATE, STOP_BITS, PARITY must be 

set. For Field Controllers operating as Modbus Master via Modbus TCP, the IP and Modbus 

addresses of up to six slaves can be defined in the SLAVE_ADDRESSES parameter

•  The ON_APPLY parameter starts Modbus after download or change in Modbus configuration

Details of these and other parameters can be taken fron the table below.

MBCF parameters Parameter Valid range/

Options

Default 

value

Description/Action

ST_VER 0 Increments on every static parameter change

TAG_DESC blanks User specific text of 32-characters to uniquely identify the 

block

STRATEGY 0 to 255 0 User specific value that may be used in configuration and 

diagnositics as a key in sorting block information

ALERT_KEY 1 to 255 1 User specific value that may be used in sorting the alarms and 

events generated by the block

MODE_BLK TARGET O/S Set to AUTO

BLOCK_ERR 0 to 15 Error status of hardware and software components associated 

with the block

MEDIA 0: Serial 

1: TCP/IP

Serial Define the type of Modbus channel.

MASTER_SLAVE 0: Master 

1: Slave

Slave Define if Field Controller is master or slave

DEVICE_ADDRESS 0 - 247 1 Define the Field Controller Modbus address (only when used 

as slave).

BAUD_RATE 0 - 10 19200 Define the baud rate (only for media serial)

0:110, 1:300, 2: 600, 3:1200, 4:2400, 5:4800, 6:9600, 

7:19200, 8:38400, 9:57600, 10:115200

STOP_BITS 0: 1, 

1: 2

1 Define the number of stop bits (only for media serial).

PARITY 0: None, 

1: Even, 

2: Odd

Even Define the parity (only for media serial)

TIMEOUT 0 - 65535 1000 Time to wait a response from a slave (for Field Controller 

master) or time to wait the OUTs be updated (for Field 

Controller slave). Value 0 is used to disable.

In the case of a slave, the TIMEOUT must be set to a value 

greater than the write cycle of the Modbus master, otherwise 

the status of the mapped values is BAD.



6 Function Block Descriptions ControlCare Application Designer: Modbus Tutorial

80 Endress+Hauser

NUMBER_

RETRANSMISSIONS

0 - 255 1 Number of retransmission if the Field Controller does not 

receive a response from a slave

SLAVE_ADDRESSES IP number and Modbus addresses of slaves (only for Field 

Controller master using TCP/IP media)

RESTART_MODBUS FALSE Indicate if after communication failure with slave, there will 

be a new transmission after the time defined in 

TIME_TO_RESTART (only for Field Controller master).

TIME_TO_RESTART 1 - 65535 1 Time to restart communication with slave

RTS_CTS FALSE Enable or disable handshaking

ON_APPLY 0: None

1: Apply

None Apply the changes made in the Modbus blocks

UPDATE_EVT This alert is generated by any change to the static data

BLOCK_ALM The block alarm is used for all configuration, hardware, 

connection failure or system problems in the block. The cause 

of the alert is entered in the subcode field. The first alert to 

become active will set the Active status in the Status attribute. 

As soon as the Unreported status is cleared by the alert 

reporting task, another block alert may be reported without 

clearing the Active status, if the subcode has changed.

Parameter Valid range/

Options

Default 

value

Description/Action
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6.2 MBCM Modbus Control Master Block

6.2.1 Block description

The Modbus Control Master block allows the Field Controller to read or write to Modbus registers 

in a slave application, e.g. a controller or field device. The values are mapped into a FOUNDATION 

Fieldbus function block, with four sets of analog and discrete I/O channels, allowing connection to 

other function blocks in a control strategy. 

•  Up to 16 MBCM blocks can be created in a project, the blocks being managed via the 

LOCAL_MOD_MAP parameter (0 to 15). Each block must be assigned a different 

LOCAL_MOD_MAP address.

•  The SCALE_LOC_XXX and LOCATOR_XXX parameters allow the configuration of the analog 

and discrete I/O channels

•  Each input or output channel is assigned to a Modbus slave through the SLAVE_ADDRESS 

parameter. The register address is entered in the MODBUS_ADDRESS_OF_XXX parameter. 

Read Values (IN) are taken from registers with 4xxxx addresses, write values (OUT) are sent 

to registers with 3xxxx addresses.

•  Analog inputs and outputs scale the slave values with the FROM_EU_XX and TO_EU_XX 

parameters and the data format is set with the DATA_TYPE parameter. 

Details of these and other parameters can be taken fron the table in Chapter 6.2.2.

MODBUS_ADDRESS_OF_

STATUS

The MODBUS_ADDRESS_OF_STATUS elements define the following rules regarding OUTPUT 

STATUS parameters:

•  If this element is set with a value that is not ZERO, the output status will behave exactly as the 

fieldbus protocol, in other words, the status will reflect the value which the master is reading 

but if after TIMEOUT (defined in MBCF block) the status is not updated, this status will be 

forced to BAD COMMUNICATION.

•  If this element is set with a value equal to ZERO, the output status will be set automatically to 

GOOD and will also accept a characterization via the ControlCare Application Designer 

(e.g GOOD CASCADE, etc). But, if after TIMEOUT (defined in MBCF block) the 

communication with the Modbus Device is not running properly, the status will be forced to 

BAD COMMUNICATION.
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6.2.2 MBCM parameters

Parameter Valid range/

Options

Default 

value

Description/Action

ST_VER 0 Increments on every static parameter change

TAG_DESC blanks User specific text of 32-characters to uniquely identify the 

block

STRATEGY 0 to 255 0 User specific value that may be used in configuration and 

diagnositics as a key in sorting block information

ALERT_KEY 1 to 255 1 User specific value that may be used in sorting the alarms and 

events generated by the block

MODE_BLK TARGET O/S Set to AUTO

BLOCK_ERR 0 to 15 Error status of hardware and software components associated 

with the block

LOCAL_MOD_MAP 0 to 15 0 Define the modbus addresses

BAD_STATUS 0 Indicates if communication from slave is good or not (each bit 

corresponds to a Modbus variable

IN_1 Analog input 1

SCALE_LOC_IN1 Scaling, data format and register addresses for input signal

IN_2 Analog input 2

SCALE_LOC_IN2 Scaling, data format and register addresses for input signal

IN_3 Analog input 3

SCALE_LOC_IN3 Scaling, data format and register addresses for input signall

IN_4 Analog input 4

SCALE_LOC_IN4 Scaling, data format and register addresses for input signal

IN_D1 Discrete input 1

LOCATOR_IN_D1 Register addresses for input signal

IN_D2 Discrete input 2

LOCATOR_IN_D2 Register addresses for input signale

IN_D3 Discrete input 3

LOCATOR_IN_D3 Register addresses for input signal

IN_D4 Discrete input 4

LOCATOR_IN_D4 Register addresses for input signal

OUT1 Analog output 1

SCALE_ LOC_OUT1 Scaling, data format and register addresses for output signal

OUT2 Analog output 2

SCALE_ LOC_OUT2 Scaling, data format and register addresses for output signal

OUT3 Analog output 3

SCALE_ LOC_OUT3 Scaling, data format and register addresses for output signal

OUT4 Analog output 4

SCALE_ LOC_OUT4 Scaling, data format and register addresses for output signal

OUT_D1 Discrete output 1
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LOCATOR_OUT_D1 Register addresses for output signal

OUT_D2 Discrete output 2

LOCATOR_OUT_D2 Register addresses for output signal

OUT_D3 Discrete output 3

LOCATOR_OUT_D3 Register addresses for output signal

OUT_D4 Discrete output 4

LOCATOR_OUT_D4 Register addresses for output signal

UPDATE_EVT This alert is generated by any change to the static data

BLOCK_ALM The block alarm is used for all configuration, hardware, 

connection failure or system problems in the block. The cause 

of the alert is entered in the subcode field. The first alert to 

become active will set the Active status in the Status attribute. 

As soon as the Unreported status is cleared by the alert 

reporting task, another block alert may be reported without 

clearing the Active status, if the subcode has changed.

Parameter Valid range/

Options

Default 

value

Description/Action
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6.3 MBCS Modbus Control Slave Block

6.3.1 Block description

The Modbus Control Slave block allows a Modbus master to read or write to values in the Field 

Controller Modbus registers. The values are mapped from a FOUNDATION Fieldbus function 

block, with four sets of analog and discrete I/O channels, into fixed registers, allowing connection 

to other function blocks in a control strategy. 

•  Up to 16 MBCF blocks can be created in a project, the blocks being managed via the 

LOCAL_MOD_MAP parameter (0 to 15). 

•  The SCALE_CONV_XXX parameters allow the configuration of the analog channels

•  Each input or output channel is assigned to a Modbus slave register through its I/O parameter 

and an OFFSET value which is 40 x LOCAL_MOD_MAP parameter. The basic addresses are 

listed in the table in Section 6.3.3. All registers are Read/Write. 

•  Analog inputs and outputs scale the slave values with the FROM_EU_XX and TO_EU_XX 

parameters and the data format is set with the DATA_TYPE parameter. 

Details of these and other parameters can be taken fron the table on Chapter 6.3.2.

STATUS_OUT_Dx and 

STATUS_OUTPUT

The STATUS_OUT_Dx and STATUS_OUTPUT elements used in the OUT parameters define the 

following rules for OUTPUT STATUS parameters:

•  If the option "Set by master" is used, the output status will behave exactly as the Fieldbus 

protocol works, in other words, the  status will reflect the value which the master is writing 

but if after TIMEOUT (defined in MBCF block) the status is not updated, this status will be 

forced to BAD COMMUNICATION.

•  If the user defines this element with anything other than "Set by master", this value will be 

reflected in output status, while communication OK, otherwise the status goes to BAD 

COMMUNICATION..
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6.3.2 MBCS parameters

Parameter Valid range/

Options

Default 

value

Description/Action

ST_VER 0 Increments on every static parameter change

TAG_DESC blanks User specific text of 32-characters to uniquely identify the 

block

STRATEGY 0 to 255 0 User specific value that may be used in configuration and 

diagnositics as a key in sorting block information

ALERT_KEY 1 to 255 1 User specific value that may be used in sorting the alarms and 

events generated by the block

MODE_BLK TARGET O/S Set to AUTO

BLOCK_ERR 0 to 15 Error status of hardware and software components associated 

with the block

LOCAL_MOD_MAP 0 to 15 0 Define the modbus addresses

IN1 Analog input 1

SCALE_CONV_IN1 Information to generate constants A and B em equation 

Y=A*X+B

IN2 Analog input 2

SCALE_CONV_IN2 Information to generate constants A and B em equation 

Y=A*X+B

IN3 Analog input 3

SCALE_CONV_IN3 Information to generate constants A and B em equation 

Y=A*X+B

IN4 Analog input 4

SCALE_CONV_IN4 Information to generate constants A and B em equation 

Y=A*X+B

IN_D1 Discrete input 1

IN_D2 Discrete input 2

IN_D3 Discrete input 3

IN_D4 Discrete input 4

OUT1 Analog output 1

SCALE_CONV_OUT1 Information to generate constants the A and B and equation 

Y=A*X+B plus output status

OUT2 Analog output 2

SCALE_CONV_OUT2 Information to generate constants the A and B and equation 

Y=A*X+B plus output status

OUT3 Analog output 3

SCALE_CONV_OUT3 Information to generate constants the A and B and equation 

Y=A*X+B plus output status

OUT4 Analog output 4

SCALE_CONV_OUT4 Information to generate constants the A and B and equation 

Y=A*X+B plus output status

OUT_D1 Discrete output 1

STATUS_OUT_D1 Status to OUT_D1 if master will not update
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OUT_D2 Discrete output 2

STATUS_OUT_D2 Status to OUT_D2 if master will not update

OUT_D3 Discrete output 3

STATUS_OUT_D3 Status to OUT_D3 if master will not update

OUT_D4 Discrete output 4

STATUS_OUT_D4 Status to OUT_D4 if master will not update

UPDATE_EVT This alert is generated by any change to the static data

BLOCK_ALM The block alarm is used for all configuration, hardware, 

connection failure or system problems in the block. The cause 

of the alert is entered in the subcode field. The first alert to 

become active will set the Active status in the Status attribute. 

As soon as the Unreported status is cleared by the alert 

reporting task, another block alert may be reported without 

clearing the Active status, if the subcode has changed.

Parameter Valid range/

Options

Default 

value

Description/Action
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6.3.3 LOCAL_MOD_MAP

MBCS MBSS

Parameter LOCAL_MOD_MAP = x

OFFSET = 40 * x

x = 0 ~ 15

e.g.

LOCAL_

MOD_MAP

Parameter LOCAL_MOD_MAP = x

OFFSET = 40 * x

x = 0 ~ 15

e.g.

LOCAL_

MOD_MAP

IN1-Value 40001+ OFFSET

40002+ OFFSET

40041

40042

FBLOCK_TAG1 42601+ OFFSET

42602+ OFFSET

42641

42642

IN2-Value 40003+ OFFSET

40004+ OFFSET

40043

40044

FBLOCK_TAG2 42603+ OFFSET

42604+ OFFSET

42643

42644

IN3-Value 40005+ OFFSET

40006+ OFFSET

40045

40046

FBLOCK_TAG3 42605+ OFFSET

42606+ OFFSET

42645

42646

IN4-Value 40007+ OFFSET

40008+ OFFSET

40047

40048

FBLOCK_TAG4 42607+ OFFSET

42608+ OFFSET

42647

42648

OUT1-Value 40009+ OFFSET

40010+ OFFSET

40049

40050

FBLOCK_TAG5 42609+ OFFSET

42610+ OFFSET

42649

42650

OUT2-Value 40011+ OFFSET

40012+ OFFSET

40051

40052

FBLOCK_TAG6 42611+ OFFSET

42612+ OFFSET

42651

42652

OUT3-Value 40013+ OFFSET

40014+ OFFSET

40053

40054

FBLOCK_TAG7 42613+ OFFSET

42614+ OFFSET

42653

42654

OUT4-Value 40015+ OFFSET

40016+ OFFSET

40055

40056

FBLOCK_TAG8 42615+ OFFSET

42616+ OFFSET

42655

42656

IN1-Status 40017+ OFFSET 40057 IBLOCK_TAG1 42617+ OFFSET

42618+ OFFSET

42657

42658

IN2-Status 40018+ OFFSET 40058 IBLOCK_TAG2 42619+ OFFSET

42620+ OFFSET

42659

42660

IN3-Status 40019+ OFFSET 40059 IBLOCK_TAG3 42621+ OFFSET

42622+ OFFSET

42661

42662

IN4-Status 40020+ OFFSET 40060 IBLOCK_TAG4 42623+ OFFSET

42624+ OFFSET

42663

42664

OUT1-Status 40021+ OFFSET 40061 BBLOCK_TAG1 2601+ OFFSET 2641

OUT2-Status 40022+ OFFSET 40062 BBLOCK_TAG1 2602+ OFFSET 2642

OUT3-Status 40023+ OFFSET 40063 BBLOCK_TAG1 2603+ OFFSET 2643

OUT4-Status 40024+ OFFSET 40064 BBLOCK_TAG1 2604+ OFFSET 2644

IN_D1-Status 40025+ OFFSET 40065

IN_D2-Status 40026+ OFFSET 40066

IN_D3-Status 40027+ OFFSET 40067

IN_D4-Status 40028+ OFFSET 40068

OUT_D1-Status 40029+ OFFSET 40069

OUT_D1-Status 40030+ OFFSET 40070

OUT_D1-Status 40031+ OFFSET 40071

OUT_D1-Status 40032+ OFFSET 40072

IN_D1-Value 1+ OFFSET 41

IN_D2-Value 2+ OFFSET 42

IN_D3-Value 3+ OFFSET 43

IN_D4-Value 4+ OFFSET 44

OUT_D1-Value 5+ OFFSET 45

OUT_D1-Value 6+ OFFSET 46

OUT_D1-Value 7+ OFFSET 47

OUT_D1-Value 8+ OFFSET 48
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